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About This Guide 

This section describes the purpose, audience, organization, and conventions that are used in 
this iPECS UCS Client for PC User Guide. 

NOTE 
The screen may look different depending on which version of the OS (Operating System) and 
Installation Program you are using. All information in this guide is subject to change without 
prior notice. 

Purpose 
This guide introduces the iPECS UCS Client for PCs and explains how to correctly install and 
use the UCS Client.  The figures and screen images used in this guide may be changed 
without notice  

Audience 
This guide provides user-related information intended for users of the PC-based UCS Client. 

Document Organization 
This guide consists of this about this guide, what's new, fifteen chapters and an appendix. The 
title of each chapter is as follows: 

 About This Guide 

 What’s New  

 Chapter 1. Introduction 

 Chapter 2. Installation and Setup Installation and Setup 

 Chapter 3. General Description General Description 

 Chapter 4. Message & Status Bar Message & Status Bar 

 Chapter 5. My Detail Information My Detail Information 

 Chapter 6. Main Window Views Main Window Views 

 Chapter 7. Quick Call Control Bar 

 Chapter 8. Tools Menu Call Features 
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 Chapter 9. Scheduling Appointments – (P) 

 Chapter 10. ICR (Individual Call Routing) Window – (P) 

 Chapter 11. Collaborative Session Tools 

 Chapter 12. Supplementary Features 

 Chapter 13. Call View & Call Function 

 Chapter 14. Audio Conference Manager 

 Chapter 15. Visual Voicemail – (UCP/eMG)  

 Appendix – A  

Document Conventions 
This section describes text formatting conventions and important notice formats used in this 
guide. 

Text formatting 
The narrative-text formatting conventions that are used as follows: 

Convention Description 

Bold text indicates a button, menu item, or dialog box option you can click or 
select 

Italic text a cross-reference, or an important term 

Code text a command prompt 

(P, S) indicates the applicable UCS license, Premium or Standard 

(UCP, CM) indicates the iPECS platform (UCP or CM) that supports the function. 
eMG system's function is exactly the same as the UCP system. 

Important notice 
The following icons and notices are used in this guide to convey important cautions and notes. 

CAUTION 
A caution statement alerts you to situations that may cause damage to hardware, software, or 
data.  

 

NOTE 
A note provides additional explanations, emphasis on important information, or a reference to 
related information. 
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What's New 

This document includes new and modified information for the iPECS UCS Client for PC User 
Guide. Click the links under each phase or version to see of what is new. 

UCS Phase 6  

Version 6.0.x 
 

User base license (Basic, Advanced, Power) 

Provides User base license to provide better user experience with simplicity and cost 
advantages. Three types of user licenses are available. Basic, Advance and Power user 
licenses.  

Refer to Unified v3 documents (Introduction, Training, Manuals) for details. 

 
Multi-login support (Need Power user license) 

UCS user with power user license can log in to multiple devices at the same time.  

Link to Multi Device Login section 

 
Enhanced UX of Call log sync & IM Continuity 

Call log sync — Call log sync is supported for a user with multiple devices.  

IM Continuity — Instant Message (IM) can continue when changing UCS clients or newly log-

in.  

Link to Multi Device Login section 

 
Automatic failover to stand-by system in Geo-redundancy/ T-Net environment (UCS 
Premium clients) 

In addition to UCS Standard clients, UCS Premium clients from v6 support automatic failover to 
stand-by call server in Geo-redundancy / T-Net environment. System can send stand-by call 
server or LCM IP address to UCS clients when initializing so that UCS clients can failover when 
disconnected to primary call server.  

Link to System Failover section
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Chapter 1  
Introduction 

This chapter is an overview of the UCS client. 

1.1 Introduction of UCS Client for PCs 
The iPECS UCS (Unified Communications Solution) Client is a PC based application, which 
operates in conjunction with the iPECS UC platform and UCS Server, expanding and 
enhancing the communication services of iPECS to dramatically improve business productivity 
and customer responsiveness. 

In addition to the rich voice services available with the iPECS system, users of iPECS UCS 
Client have access to a wide range of video, text, collaborative and messaging services. 
Services available include Presence, Video Conferencing, Instant Messaging, Sharing 
(Application, Desktop and Whiteboard), Individual Call Routing (ICR), and more.  

Employing a simple intuitive graphical user interface, the UCS Client has access to both private 
and shared scheduling and directory database applications, which are fully integrated with the 
various services available in the iPECS UC platform and UCS Server. The UCS Client user 
interface is highly flexible and can be customized to address the needs of the individual user. 

Further, the UCS Client database applications can interoperate and synchronize with major 
personal information management applications and databases such as Outlook, ACT!, 
Goldmine, Excel and LDAP.  

As an Internet Protocol (IP) solution, the UCS Client overcomes geographical limitations 
allowing access to services and databases while in the office or on the road. 
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Chapter 2  
Installation and Setup 

Installation and set-up of the iPECS UCS Client is a simple four-step process: 

 Step 1: Verify your hardware and operating system 

 Step 2: Install the iPECS UCS Client application on the user’s PC. 

 Step 3: Adjust UCS Client login settings. 

 Step 4: Login to complete registration of the iPECS UCS Client application to the iPECS 
system and UCS Server. 

Completing the login and registration process may require assistance from the iPECS 
Administrator to adjust settings of the iPECS system and the UCS Server; both will require the 
client User ID and Password. iPECS UCS Client will require entry of the host iPECS system 
and UCS Server IP address. 

Prior to installation, the PC and operating system should be verified for compatibility with the 
iPECS UCS Client application. Assure that the PC and Operating System (OS) comply with the 
minimum requirements of Section 2.1. 

2.1 PC Hardware and OS Requirement 
The UCS Client application software requires a PC with the minimum configuration defined 
below. 

2.1.1 PC Hardware: 
 CPU: Intel Core2 Duo 2.8 or higher (Normal UCS Operation: Voice Call, Presence, IM, etc.) 

Intel i3 or higher (Special UCS Operation: Point-to-Point 4CIF Video call) 

Intel i5 or higher (Special UCS Operation: Multiparty Video call) 

 RAM: minimum 2 GB of DRAM, recommended 4GB; (4GB required for 4CIF usage) 

 Hard disk space: 200 MB of HDD storage 

 Monitor: 17” recommended, with a resolution of 1024 x 768 

 LAN card : 100/1000 Base T NIC (Network Interface Card) 

 CD ROM drive 

 Standard Keyboard and Mouse 
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 Web Cam for Video Conference (optional) 

 Sound card and Microphone installed 

 USB headset (recommended) 

NOTE 
Voice quality is highly dependent on the quality of the headset. 

 

2.1.2 Operating System: 
 Windows 7 Professional 

 Windows 8 Professional, Windows 8.1 Professional 

 Windows 10 

2.1.3 Client Virtualization: 
For client Virtualization, UCS Client supports Virtual Desktop Infrastructure (VDI) and Remote 
Desktop Service (RDS). Client Virtualization has been tested in VMware Workstation 11.0 and 
Citrix XenDesktop 7.6 and XenApp 7.6 environment and Windows Server 2012 Remote 
Desktop Service.  

Virtual desktop infrastructure (VDI):  
VDI is a process of running user desktops inside virtual machines that are hosted on data 
center servers. In a VDI environment, each user is allotted a dedicated virtual machine that runs 
a separate operating system. This flexibility provides an isolated environment for the user. 

Remote Desktop Service (RDS):  
RDS sessions involve multiple users using the same VM and server OS.  RDS, a proprietary 
protocol of Microsoft, allows users to connect remotely to a network with a graphic user 
interface. While the RDS client is installed on the user system, the RDS server software is 
installed on the server, and a remote connection is established with one or more terminal 
servers. While users in the RDS network connect to the server using a VM, this VM is shared 
with other users and operates on the same server operating system (OS) for all users. 

NOTE 
RDS is supported since UCS 5.5 version. 
In RDS environment, the following are not supported: Call from outlook contacts, Video related 
functions (Video Call/ Video Conference/ Remote Monitoring). 
For most virtualized environments Call Control Mode with no voice is recommended, as there 
are limitations with real-time audio and video. 
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2.2 License and Lock Key 
Prior to registration of iPECS UCS Clients with the host iPECS system and UCS Server, the 
host iPECS system will require installation of a UCS Client software license. The administrator 
must enter a lock-key code in the iPECS system. 

iPECS UCS employs a seat-based license scheme. In this scheme, the maximum number of 
registered UCS Clients is set in the installed lock-key. For information on Lock-keys, contact the 
local Ericsson-LG Enterprise distributor. 

2.3 iPECS UCS Client Installation 
This section explains how to install the iPECS UCS Client. The software can be obtained by 
download from the iPECS UCS Web Admin Download Client Program window or from the 
iPECS UCS Client CD-ROM. Download from the iPECS UCS Web Admin may require 
assistance of your iPECS Administrator. 

2.3.1 To obtain the software by download: 
１. Open a browser on the PC. 

２. Point the browser to http://ip address of UCS Web Admin/UCS, your iPECS Administrator 
should have the IP address. 

 

  
３. Click the Click to download UCS Client Program link at the lower-left of the screen. 

４. Select the Windows (PC) Download button. The Windows File Download Security screen 
displays: 
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５. Select Save to save the UCS Client application in the designated directory, or select Run to 
install UCS client directly on the PC. 

 
 

2.3.2 To install the UCS Client application: 
If “Run” was selected in step 5 above, the UCS Client Install Wizard appears. If “Save” was 
selected; find and run the UCSClient.exe file received during download.  

１. The UCS Client Install Wizard should appear, click Next to continue. 

 
 

２. The software License Agreement window appears. Read and accept the license terms, and 
click Next. 
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３. In the Customer Information window, enter your User Name and Organization; select the radial 
button for all users or “Only for me” then click Next. 

 
 

４. In the Destination Folder window, you may either accept the default destination (C:\Program 
Files\UCS Client), which is recommended or select Browse to locate a different directory or 
specify a directory. If you specify the directory, do not include spaces or special characters. 

 
 

５. Click Next to install WinPcap 4.1.3. WinPcap is a standard tool for link-layer network access in 
the Windows environment. The WinPcap Installer is imbedded in the UCS Client Installer, and 
opens automatically. 
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６. The WinPcap software License Agreement window appears. Read and click I Agree to 
continue the installation. The WinPcap installer begins copying files onto your hard disk. 

 

７. After successful installation of WinPcap, click Finish to complete WinPcap installation. 

 

８. When all files have been downloaded, the Installation Completed window is shown, click Finish. 
The iPECS UCS Client application can open automatically when Windows starts; click the box 
for “Run UCS client automatically when Windows starts” to enable. 



 

 
iPECS UCS Client for PC User Guide - Issue 4.7 11 

 

2.4 Initial Setup and Login 
To setup the UCS Client application, perform the following steps: 

１. After installation, click on UCS Client from the Programs listing in the Windows Start menu or 
click the desktop shortcut icon created during the software installation. 

 
 

NOTE 
When Windows OS needs to be updated, UCS Client might to have no access to write 
configuration files of UCS Client like below notification message and cannot be logged in. 

 
 
In this case, you need to restart Windows for UCS Client to access to those files and login 
successfully. 

 
２. Once launched, the iPECS UCS Client Login screen will appear. For the initial installation, you 

must define the IP address and other basic parameters for the iPECS system, UCS Server and 
client in the General Setting window. Select Setting from the File menu, the Server Connection 
window displays. 
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３. For UCS Server Connection, enter the IP Address of the UCS Server provided by your iPECS 
Administrator, or if already shown, check Use Detected Server IP.  

 
 Select OK to save the new values.  

４. When finished, login by entering your User ID and Password. Remember, the User ID and 
Password are case sensitive.  

 
 The User ID and Password may be 2-12 alphanumeric characters and the Password may 

include symbol characters. 

 In a single user environment, use the Auto Login, Remember User ID and Password 
checkboxes, to automate login to the iPECS system and UCS Server every time the UCS 
Client application is launched. 



 

 
iPECS UCS Client for PC User Guide - Issue 4.7 13 

５. Click Login to initiate the iPECS UCS Server and system login; the UCS Client Console should 
display. 

NOTE 
If no audio device is defined in the PC, a warning dialog is displayed and the UCS Client will not 
open. With Windows 7 and Windows Vista (not recommended as OS) the warning message is 
also displayed if the audio device is not connected. Clicking “Yes” in the Warning Dialog box will 
open UCS Client without audio capabilities. 
If the number of Login attempts reaches the threshold assigned by the UCS Server 
administrator, the User account is locked. To unlock the account, either the administrator must 
unlock the account or the assigned lockout duration timer must expire. 

2.5 Single Sign-On 
If user’s Windows is joined in Active Directory, Single Sign-On (SSO) check box will be 
displayed on UCS Client login window.  UCS User can login using joined Domain Name and 
User ID. When checking Single Sign-On check box on login window, joined Domain Name and 
user ID is displayed. Then, by clicking Login button, UCS user can login without user ID and 
password.  This function is supported in Premium license. 

１. If user’s Windows is joined in Active Directory, Single Sign-On check box will be displayed on 
UCS Client login window. 

 
 

２. When checking Single Sign-On check box on login window, joined Domain Name and User ID 
is displayed.  Click Login button, then user can login without user ID and password. 
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NOTE 
For Single Sign-On, SSO property in UCS Web admin must be set to ‘true’. 

 

2.6 Multi Device Login 
UCS Client can login in one of the different kinds of devices. It is allowed to login in maximum 
three kinds of different devices at the same time. The following is a description of the device 
type classification. 

 Desktop Type: Windows(PC) / MAC Client 

 Mobile Type: iPhone Mobile / Android Mobile Client 

 Tablet Type: iPad Tablet / Android Tablet Client 

NOTE 
1) Multi Login is not allowed to login in with same kinds of device. That is to say if you are 

trying to login in Mac Client while logged in Windows PC Client simultaneously, the 
Windows PC Client is logged out, and then MAC Client is allowed to login in. 

2) For example, allows Multi Login Combination is ‘Windows (PC)’ + ‘iPhone Mobile’ + 
‘Android Tablet’. 

 
１. Presence and Call Log Synchronization: Multi-Login Devices share same presence and Call 

Log 

２. Simultaneous Ring Support: When an incoming call is ringing, Multi-Login devices are ringing 
at the same time.  

３. IM Message Synchronization: Multi-Login devices are received same IM message. 
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Chapter 3  
General Description 

3.1 PC Client Screen 
The UCS Client Console consists of the Main application menu (File, View, Tools and Help), 
Message and Status bar, My Detail information, main window for Presence, Phone, Logs and 
Call View, and Quick Call Control bar.  

The 5 parts of the UCS Console are described as follows: 

 The File, View, Tools and Help menus are discussed in Section 3. 

 The Message Status bar is discussed in Section 4. 

 The My Detail Information is discussed in Section 5. 

 The main Window for Presence, Phone, Logs and active Call views is discussed in Section 
6. 

 The Quick Call Control bar is discussed in Section 7. 

 
 UCS Client Main Screen 

Main Application menu (File, View, Tools and Help) 

Message Status bar (displays new Voice Mail, IM, 
Note and Missed Call) 

My Detail Information 

Main Window for (Presence, Phone, 
Logs and Call View) 

Quick Call Control Bar 
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3.2 File Menu Selection 
The Main Application menu at the top of the console includes menu selections for File, View, 
Tools and Help. Click on File to show the following selections: 

 
 Login/Logout – initiates the login or logout process with the iPECS UCS Server and system, 

see section 2.4. 

 Open Received Files – opens the folder where files received from other UCS Client users 
are stored. 

 Open Received Voicemail – opens the folder where voicemails downloaded from System 

are stored.  This function is supported in UCP/eMG system. 

 Set My Presence – defines your IM presence state. 

 Set My Phone Status – sets the phone status. 

 My Information - displays your detailed information. 

 Setting – displays the Setting window, where you set up and customize the iPECS UCS 
Client. 

 Close – minimizes the iPECS UCS Client application to the Windows notification tray. 

3.2.1 Set My Presence 
Presence establishes your availability to be part of an Instant Messaging (IM) session. iPECS 
UCS Server monitors and automatically updates your Presence as Online, Offline, Busy or In a 
Meeting. The presence of other users is also provided in the Presence window (refer to Section 
6.1).  

Your status is displayed by the IM Status icon, which is located on the left above your picture.  

You may change the status with the Set My Presence selection in the File menu, or by clicking 
the IM Status icon. 
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To change the UCS Client IM status: 

１. Select Set My Presence from the File menu. 

  

２. Select the IM status (presence) desired from the status window. 

3.2.1.1 Set or Release DND All 
‘Set/Release DND All’ settings are used when you want to change my phone status, as well as 
even my presence together. 

Set DND All: 

１. Select the ‘Set DND All’ from the status window. 

 

２. My Phone status and My Presence status will be set also. And, ‘Set DND All’ button will be 
changed into ‘Release DND All’.  

 
Release DND All: 

１. Select the ‘Release DND All’ from the status window. 
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２. My Phone status and My Presence status will be released at the same time. And, ‘Release 
DND All’ button will be changed into ‘Set DND All’.  

NOTE 
Only when both My Presence status and My Phone Presence status are set into DND states,   
will ‘Release DND All’ Button be displayed.  If one of their states is not in DND status, ‘Set 
DND All’ Button will be displayed. 

3.2.2 Set My Phone Status 
Using Set My Phone Status, the UCS Client can be placed in a Do-Not-Disturb state or calls to 
the UCS Client may be sent (forward) to another destination.  When in DND, internal callers 
receive a fast-busy tone and outside callers are routed based on iPECS system admin settings.   

Simple Call Forward is activated from the phone allowing the user to define the type of Call 
Forward (all calls, busy, and no-answer) and destination for the calls.   

Remote Call Forward or Follow-me forward is activated from a different phone allowing the 
user to define the type of calls to forward and the destination for the calls.  For Follow-me 
forward, the user must also enter the station number and the password (Authentication code) 
to activate Remote Call Forward.   

Call Forward ICR accesses the Individual Call Routing feature where the user can define 
various Call routing scenarios as discussed in Section 10. 

 

NOTE 
When DND or Call Forward is activated, a confirmation window will be displayed at next login, 
DND or Call Forward can be deactivated in the confirmation window. 
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3.2.2.1 Clear All 
You may deactivate Call Forward or DND with the Clear selection in Set My Phone Status sub-
menu of the File menu, or by selecting the Phone status icon. 

To deactivate Call Forward or DND: 

１. Select Set My Phone Status from the File menu or the Phone status icon. 

２. Select Clear from the status window.  

  
 

3.2.2.2 Set Do Not Disturb (DND) 
You may activate DND with the Set My Phone Status selection in the File menu, or by selecting 
the Phone Status icon. 

To activate DND: 

１. Select Set My Phone Status from the File menu or the Phone status icon. 

２. Select DND from the status window. 

 
 

3.2.2.3 Set Simple Call Forwarding 
You may select to re-route incoming calls to other stations, station groups, the system Voice 
Mail, or to an outside number. You may forward calls based on your IM presence state and 
define the forwarding type (condition) for calls. 

To activate Call Forward: 

１. Select Set My Phone Status from the File menu or the Phone status icon. 

２. Select Call Forward (Simple), the Simple Call Forwarding window is displayed. 

Phone Status icon (    ) 
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３. In this window click on and enter the Destination information (as needed). 

４. Select the IM status required to forward calls or select All IM Status to forward calls regardless 
of the IM Presence state.  

５. Select the Forwarding Type. 

６. Click OK to activate Call Forward. 

3.2.2.4 Set Remote Call Forwarding 
To activate Call Forward, Remote (Follow-me): 

１. Select Set My Phone Status from the File menu or select the Phone status icon. 

２. Select Call Forward (Remote), the Remote Call Forwarding window displays. 

 

３. Input your Remote Station number. 

４. Input your Station Authorization Code (Password) 

５. Input the Station or Station Group to receive calls. 

６. Select the desired Forwarding Type. 

７. Click OK to activate Call Forward. 
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3.2.2.5 Set ICR (Individual Call Routing) 
Setting Call Forward ICR (Individual Call Routing) is discussed in Section 10. 

3.2.3 Setting 
The Setting menu provides a number of pages to configure the UCS Server connection, UCS 
Client appearance, sound and other characteristics discussed in this section. When Setting is 
selected in the File menu, the first Setting page, Server Connection, will display. 

 
 

The Setting window is divided into two screens, on the left is the Setting menu navigation pane 
and on the right is the data entry pane. Selecting a category in the navigation pane displays the 
associated data pane.  

 
The options below can be configured after logging-in the Call Server because these functions 
need to receive configuration information from system: 
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 Call – Dialing Rules/ Call Popup/ Ring Sound/ Audio/ Voice Codec/ Recording 

 Functions – LDAP 

NOTE 
Before logging-in, “The selected option can be shown after logging in the Call Server. 
Please contact your Call Server first.” message will be displayed. 

 

The following sections cover each data item in each category available from the navigation 
pane. 

3.2.3.1 Server Connection 
Normally, once the Server Connection items are entered during the initial installation further 
changes will not be required (refer to Section 2.4).  In cases where the PC has multiple 
Network Interface Cards (NICs) or a Virtual Private Network (VPN), the proper Network adapter 
must be identified.  The Network adapter is selected under the Advanced button of the Server 
Connection Setting window. 

To modify any of the Server Connection settings: 
Select Setting from the File menu, the Server Connection window displays. 

 

１. Change the desired item(s). 

２. Click Apply or OK to exit. 
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In the Server Connection screen, the selections are: 

UCS Server Connection 
 Use detected server IP – when the UCS Client application is launched, it attempts to locate 

a local iPECS UC server. If found and this item is checked, the UCS Client will use the 
located UC server for services. 

 IP Address – input box for the IP Address or domain name of the UC server.  

 Server Relay Mode – relay mode between the UCS Clients; Auto is recommended. 

– Auto – Session connection is determined by the UCS Client automatically. 

– Enable – Implements the server relay function so that the UCS Client can establish a 
connection to others when separated by a firewall.  In this case, the UC server acts as a 
relay to distribute session (IM, File Send and Sharing) packets to other users.  This 
mode connects UCS Clients separated by a firewall. 

– Disable – Implements a peer-to-peer connection for the session. 

Call Server Connection 
 PBX IP Address – IP address of the iPECS host system serving the iPECS UCS Client. 

 Connection Mode – connection mode between the UCS Client and the iPECS; Auto 
Connection mode is recommended. 

– Auto – selects either Local or Remote automatically. 

– Local – connection is employed when the iPECS system and UCS Client are on the 
same LAN. 

– Remote – supports packet relay. 

 UCS License – selects either Standard or Premium. 

– Standard – UC server is embedded in PBX and function is restricted compared to 
Premium. 

– Premium – UCS Server is installed in independent PC and enhanced functions are 
available. 

 Call Control Mode – UCS Client can control desk phone which is configured in [Control No.] 
field. [Control No.] will be saved in each user’s profile file and used to login UCS Client. Call 
Control selects either With Voice or No Voice. 

 
 

– With Voice – UCS Client provides an audio path for voice, so you can call without a 
desk phone. In case of UCP /eMG system, UCS Client can control desk phone which is 
configured in [Control No.] field. But in CM system, [Control No.] will be ignored in With 
Voice mode, because CM system doesn’t support call control in With voice mode. 
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– No Voice – UCS Client is employed for call control only; the client does not provide an 
audio path for voice. A desk phone is required.  For No Voice, you must set the [Control 
No.] and [Password] fields. 

NOTE 
UCS Client may have some limitations in control call of SIP Phone.  
For call control to operate correctly, UCP/eMG and CM systems need to be configured in 
web admin of each system.  Please refer to system user manual for detailed information 
about call control configuration. 
When No Voice mode is used in standard license of UCP/eMG system, video is not 
supported. 

 
Advanced Settings 

 
 

 Connect with Selected Adapter – enables selection of a specific network adapter. 

 Your Current IP – displays current IP Address. 

 Network Adapter Selection – displays network adapter list; select the desired network 
adapter. 

Network Diagnostics 
 This function is supported in UCS Premium license. 
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 Test Start – start network diagnostics 

 Cancel – cancel network diagnostics 

 Ping Test – ping test option between a UCS Client and UC server.  

 UDP Message Test – application message test option between a UCS Client and UC server. 

 Send To Email – sends the test results as an E-mail attachment. 

 Save – saves the test result to a file. 

 Close – exit network diagnostics. 
 

Defined Profiles can be selected from the drop-down list or added/edited/deleted with the 
Profile Name Tool buttons: 
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１. Select Profile Name. 

２. Click on the Add or Edit tool button. 

３. Click to select/deselect the Use Detected Server IP option. 

４. Enter the IP address, Login Timeout. 

５. Select the Server Relay Mode and Connection Mode.  

６. Click on OK. 
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3.2.3.2 General 
The General category consists of several sub-categories for the Basic Action, Display and 
Sound pages.  Items on each page are discussed below.  Note that the Theme and Presence 
color can be changed only if the client is not logged-in 

To modify any of the General category settings: 

１. Select Setting from the File menu, the Server Connection window displays. 

２. Select the desired sub-category under the General heading. 

 
 

３. Change the desired item(s). 

４. Click on the Apply or OK to exit settings. 
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3.2.3.2.1 Basic Action page 
The Basic Action page includes the following items: 

 Set the action for double-clicking – when double clicking on a user record in the Presence 
window, UCS Client will take the action selected from the drop-down list (Call, IM, Detail 
Information and No Action). 

 Auto-Start on Startup Window – when enabled, UCS Client launches when Windows 
starts. 

 Login Notification – if enabled, at login the login notification message is displayed. 

 Show DND or Call forward Confirm window on login – if enabled, the DND or Call 
Forward confirm window is displayed at login. 

 Enable Auto away – if enabled, when there is no activity on your computer for the Auto 
away time (minutes) you set, the IM status is set to Away. 

 Do not display expired appointments in Today’s Schedule Viewer – if enabled, once an 
appointment expires, the appointment is removed from the My Detailed Information window. 

 Show confirm window when no speaker or microphone – if enabled, a warning message 
is shown when attempting to open UCS Client on a PC without a speaker or microphone.  If 
disabled, UCS Client will open even if no audio devices are connected to the PC.  However, 
calls cannot be placed from the UCS Client since no audio devices are available. 

 My presence for an Appointment –the presence status changes to the entered status 
automatically at the start of a UCS schedule. 

 My presence After Expired – the presence status changes to the entered status 
automatically at the completion of a UCS schedule. 

 Busy Status Appointment – the presence of the UCS Client changes to the entered status 
at the start of an imported Outlook schedule where the presence has been set to “Busy”. 

 Out of Office Status Appointment –the presence of the UCS Client changes to the 
entered status at the start an imported Outlook schedule where the presence has been set 
to “Out of Office”. 
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3.2.3.2.2 Display 

 
 

 Language – selects the display language (English or Local). 
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3.2.3.2.3 Sound 

 
 

 Program Start Notification – when enabled, play the Program Start alert. 

 Program End Notification – when enabled, play the Program End alert. 

 New IM Notification – when a new IM message is received and notification is enabled, the 
new IM message warning tone is received.  Note the warning tone is not received while the 
IM window is active. 

 Administrative message Notification – when enabled and a message is received from 
UCS administrator, play the notify message Sound. 

 Logon Notification – when enabled and the user logs in, play the logon notification sound. 

 Mute All Sounds – click to deactivate all sounds. 
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3.2.3.2.4 Outlook Integration 

 
 

 Disable Outlook Security Warning – when enabled if the UCS Client accesses Outlook 
information such as the address book, mail or appointments, the Outlook security window is 
bypassed and the information is displayed. 

 Enable Outlook Schedule (Auto Synchronization from Outlook to UCS) – enables 
synchronization between iPECS UCS user’s Private schedules and Outlook.  At login, the 
UCS Client may present a confirmation window so that you may confirm synchronization 
with the Outlook schedules.  If confirmed, UCS Client will download the schedules from 
Outlook.  After login, if schedules are changed in UCS, the Outlook schedules are also 
modified. 

NOTE 
Only schedules for the current and next month are synchronized. 
Schedules from the previous months, or beyond the next month are not synchronized. 

 
 Set Default Folder – when checked, the UCS Client calendar is synchronized to the default 

Outlook calendar folder. 

 Show Outlook Synchronization Confirm window – when Outlook calendar 
synchronization is enabled, a confirmation window can be presented allowing you to allow or 
disallow synchronization. 
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 Open Synchronized Appointments to All Shared users - when Outlook appointments are 
synchronized, the appointments are shared based on this selection. You may select ‘Do Not 
Open to All Shared users’, Open to All Shared Users or ‘Follow the Property of Outlook’.  
Selecting ‘Follow the Property of Outlook’ option, shares appointments based on sharing 
options in the Outlook appointment. 

 Enable Outlook Contacts (Auto Synchronization from Outlook to UCS) – when enabled, 
the UCS Client Private Directory and Outlook contacts synchronize during login.  At login, 
the UCS Client may present a confirmation window so that you may confirm synchronization 
with the Outlook contacts.  If confirmed, UCS Client will download the contacts from 
Outlook.  After login, if the contacts in UCS are modified, the Outlook contacts are also 
modified.  

 Set Default Folder – when checked, the UCS Client Private directory is synchronized to the 
default Outlook Contacts folder. 

 Show Outlook Synchronization Confirm window – when Outlook contact synchronization 
is enabled, a confirmation window can be presented allowing you to confirm synchronization. 

 Delete All Imported Private Users Before Synchronization – If enabled, at login all 
previously imported contacts will be deleted before synchronization.  

 Show Synchronization Result - when enabled, you will be presented a window displaying 
the results from the synchronization. 

  



 

 
iPECS UCS Client for PC User Guide - Issue 4.7 33 

3.2.3.3 Call 
The Call category includes settings for Dialing rules, call pop-up boxes and several audio 
settings as discussed below. 

To modify any of the Call category settings: 

１. Select Setting from the File menu, the Server Connection window displays. 

２. Select the desired sub-category under the Call heading. 

３. Change the desired item(s). 

４. Click Apply or OK to exit settings. 

3.2.3.3.1 Dialing Rules 
When placing an outside call from any of the UCS Client windows (e.g. Presence, Logs, etc.), 
certain digits may need to be included or removed to assure proper dialing through the iPECS 
system.  When a number is selected from a window, the UCS Client will compare the number 
to the dialing rules.   

NOTE  
For ucs user to use Dialing Rules, below options need to be set to ON.  
1) In case of UCS Standard License, [UCS DIALING RULE USE] option should be set to ON. 
You can find [UCS DIALING RULE USE] option in Unified Web Admin – PGM112. 
2) In case of UCS Premium License, [Allow UCS Dialing Rule] option should be checked. You 
can find [Allow UCS Dialing Rule] option in UCS Server Web Admin – Use Feature Permission. 

The dialing rules country and area codes are compared to the number, and if matched, are 
deleted from the number.  If not matched, the appropriate Area (LD) or International codes will 
be inserted, preceded by the PBX, CO or IP line access codes.  

[Lookup Number] menu will be displayed when [UCS Dialing Rule] is OFF 

 
 Lookup Number is needed to search the user information from caller’s phone number. 
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 [Access Code] menu will be displayed when [UCS Dialing Rule] is ON. 

 
 

 Access Codes – entered in the Dialing Rules window, along with local codes for 
comparison. 

 Add a zero before the area code when dialing within the country – if enabled, includes 
the area code with the leading zero when dialing within the country. 

 Enblock Dialing – when enabled, digits dialed for a call are sent at one time rather than 
sending each digit as dialed.  When IP Bridge mode is enabled, it is recommended that 
Enblock Dialing be enabled.  Note that for proper operation, Phonebook entries should 
follow normal conventions (ex., +country code (area code) number [ex., +41 (041) 4904636]) 

 
Advanced Dialing Rules 

 
 

 Filtering Code – code is used for special cases to search contact directories.  To add this 
code, please ask your system administrator. 

 Insert Numbers if ‘=’ is found – replaces ‘=’ with the assigned number.  This is useful to 
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dial a long number. 

 Pause Time (ms) if ‘P’ or’,’ is found – if a number includes the pause code, ‘P’ or ‘,’, 
dialing pauses for the timer value in milliseconds set here. 

 If the area code is required for local dialing, the Dial Area Access Code In Same Area 
option must be checked. 

 
Special Dialing Rules 
Normally, dialed numbers that do not have an area or country code defined in the dialing rules 
are routed as an internal call.  Using the Special Dialing Rules, dialed numbers matching the 
defined rules are routed as external CO calls. 

 

 Prefix Digits – If the first digits in a dialed number match the assigned ‘Prefix Digit(s)’, the 
call is routed as an external CO call and the CO access code is added automatically. 

 Length – If the length of the dialed number is longer than the defined length, the call is 
routed as an external CO call and the CO access code is added automatically. 
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3.2.3.3.2 Call Popup 

 
 
▼ 

 
 

 Call Pop-up – check to enable the UCS version Call Popup. 

 Outlook Pop-up – when Call pop-up is enabled, the client will display either the UCS popup 
shown above or the Outlook popup. Check to enable the Outlook Popup in place of the UCS 
popup. If you check Internal Call, the Outlook popup will also display for internal calls.  The 
default folder for the Outlook contacts must be defined. 

NOTE 
For Outlook Pop-up function, Outlook Pop-up property in Web Admin must be set to ‘True’. 
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 Call Popup Trigger – defines the event that will cause display of the selected popup, both 
incoming calls and outgoing calls may trigger the call popup. 

 Call Window Option – the Call tab in the main window can be displayed when a call is 
connected or when a call is answered or dropped with Enter key in the popup window.  
When you set ‘Display Registered Call Memo on Call Pop-up’, incoming and outgoing calls 
are displayed in the Call Memo window. Also, if you want to activate the Call Memo window 
automatically when a call is received, select the ‘Show Call Memo Window Automatically’ 
option.  For more information about the Call Memo window, refer to Section 8.8.  Select 
the ‘Show Flex Button Window when Phone Tab is open’ to see the Flex Button window 
automatically when the Phone tab is selected. 

NOTE 
For correct operation with ‘Answer/Drop a Call with Enter Key in Call Pop-up Window’ enabled, 
the UCS call popup must be the active window.  If the Outlook call popup is selected or you 
select a different window while the UCS call popup is displayed the call cannot be answered or 
dropped with the Enter key. 
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3.2.3.3.3 Ring Sound 
iPECS UCS Client can provide one of four (4) ring signals with separate assignments for 
internal and external calls. Each of the four (4) ring signals is contained in an *.wav file. You 
may select one of the four *.wav files (ring1.wav, ring2.wav, ring3.wav and ring4.wav) or 
replace any of these files with a desired *.wav (PCM) or *.mp3 file.  

 
 

 Station Ring – selects the ring signal for internal calls. You can check the ring signal in 
advance. 

 CO Ring – selects the ring signal for external calls. You can check the ring signal in 
advance. 

 Ring Style – one of three ring volume treatments can be selected, minimum, gradually 
increase, or at the specified volume. 
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3.2.3.3.4 Audio 
The UCS Client will deliver tone signals (ring) as well as voice signals to the defined device.  
Select a Speaker to receive Ring/DTMF and select a Speaker and a Microphone for voice 
communication. The Speaker is defined separately for voice and ring signals.  

 
 

Audio Wizard 

 
 Device for Ring/Tone – defines the devices for ring and tones.  PC Speaker Beep tone will 

sound for incoming calls if this option is enabled. 

 Device for Voice – defines the devices, speaker and microphone, for voice communication. 

 Audio Tuning Wizard – assists in adjusting the volumes for the Speaker/Microphone. 
 

There are three ring styles for an incoming call ring signal, minimum, gradually increase, or at 
the specified volume. From the wizard, the style selected is played allowing you to determine if 
it is acceptable. If you check Enable PC Speaker Beep, the beep is played. 
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On the Communication Test page of the wizard, you can check the volume level of the speaker 
and microphone. Any sound picked up by the microphone is displayed under the microphone 
section of this page. The volume level varies if the PC sound devices are properly set. If you set 
‘Let UCS adjust microphone volume’, Automatic Gain Control (AGC) is used to adjust the 
microphone volume. 

 
These options can improve voice quality in noisy environments. By increasing the noise 
suppression, noise patterns are removed during conversation. For example, if you say ‘Ah~’, 
continuously, the pattern will be removed from the conversation. 

 
 

 Headset Integration – when headset integration is enabled, operation of the headset hook-
switch function for answering or dropping a call is recognized when using one of several 
headsets. The supported headsets with the hook-switch function include: 
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– Audio 910 Headset 

– CS 50/60 USB Headset, press volume up or down button for more than 3 seconds to dial 
the assigned numbers. 

– GN8120 Headset 

– Common Devices – Plantronics 

– Common Devices – GN Netcom (Jabra) 

NOTE 
The operation of remote hook-switch varies between headset manufacturers and models.  To 
use one of the listed headsets with UCS Client, refer to the manual packaged with the headset. 

 
To use the hook-switch function when a “Common Device” is selected, special Windows drivers 
are required. These drivers are available on the UCS Server and may be downloaded using the 
link at the bottom of the Headset Integration page or from the Client download page accessed 
from the UCS Server login page. In addition, for the Plantronics Common Devices, 
Microsoft .Net Framework 3.5 or later is required. The UCS Client will check for this software 
and, if not installed, you will be prompted to download and install this software prior to 
installation of the drivers.  
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3.2.3.3.5 Voice Codec 

 
 Select Codec – defines the preferred codec (System codec, G.711 or G.729). 
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3.2.3.3.6 IP Bridge 

 
 Enable IP Bridge – the UCS Client can be linked with an iPECS desktop IP Phone so that a 

call can be placed from the client and the voice path established through the IP Phone by 
lifting the handset or pressing the Speaker button. 
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3.2.3.3.7 Recording 

 

 Recording Folder – defines the folder where recorded call files are stored. 
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3.2.3.3.8 Click to Call 

 
 Enable Capturing Numbers by Mouse Dragging - when you drag your mouse over a 

phone number in a browser window, the number is captured into the Quick Call Control Bar 
and the Call Assistance.  However, capturing over several windows is not allowed.  For 
example, capturing will not work if you click the left mouse button to start in one program 
window and release mouse button in another program window. 

 Enable Shortcut Key – UCS Client support Shortcut Key such as below. 

– Dialing: call using configured Shortcut Key 
– ON: Click to Call function ON 
– Off: Click to Call function OFF 

 

NOTE 
Characters captured can be numeric digits, ‘+’ (plus sign), - (dash) and ‘,’ (comma). If number 
capture fails, try restarting UCS Client to update Setting/Call/Click to Call configuration. 
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3.2.3.4 Functions 
Under Functions, settings are available for Sharing, video, IM logging and database 
characteristics as discussed in detail below. 

To modify any of the Function category settings: 
１. Select Setting from the File menu, the Server Connection window displays. 

２. Select the desired sub-category under the Function heading. 

 

３. Change the desired item(s). 

４. Click Apply or OK to exit settings. 

3.2.3.4.1 File 
 File Receiving Folder – defines the folder where files received from other UCS Clients are 

stored. 
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3.2.3.4.2 Sharing 
 

Application Sharing 

 
 Application from Share List – only shares files from the Shared List during a sharing 

session (refer to Section 11.3.3). 

 Any windows in the Shared Window – shares all windows that are moved or displayed in 
the Sharing window including files in the Shared List, refer to Section 11.3.3.  Certain types 
of files such as Internet browsers may not be recognized by the sharing module as 
applicable to sharing.  In this case, selecting Any Windows in the Shared Window allows a 
window to be drag to the Sharing window for display to participants. 

 Capture Resolution – sets the capture resolution (10, 20, 50, 80, and 100%). Higher 
resolution improves quality but can significantly increase LAN traffic. 

Desktop Sharing 
 Capture Resolution – sets the capture resolution (10, 20, 50, 80, and 100%).  Higher 

resolution improves quality but can significantly increase LAN traffic. 
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3.2.3.4.3 Video 

 
 Video Frame rate – sets the video frame rate (Slow, Normal, and Fast).  Because added 

processing time is required, faster frame rates may affect quality. 

 Device for Video – sets the video input device.  If there are more than two devices, the 
user may select a device from the list. 

 Allow Video Request Automatically – when enabled, automatically answer all incoming 
video requests. 
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3.2.3.4.4 IM 

 
 Enable IM Log – enables the IM Log, all IM sessions are stored until erased, refer to 

Section 6.3. 

 Popup On New IM Message – enables the minimized or hidden IM window to popup when 
a new IM message is received. 

 IM Window Popup Position on Multi-Monitor – sets the popup position of the IM window 
in Multi-monitor environments. 

– Monitor where UCS main window is shown – IM Window will be displayed at the 
monitor where the UCS Client main window is shown. 

– Primary monitor – IM window will be displayed at the primary monitor where Start Menu 
and Desktop Shortcuts are displayed by Windows. 

– Whole of Central Desktop – IM window will be displayed in the center of the screen. 
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3.2.3.4.5 LDAP 
LDAP Server information is transferred from UCS Sever during login.  Therefore, after logging-
in UCS Client, UCS user can choose LDAP Server. 

 
 

 Server Name – identifies the LDAP Server. A LDAP server defines the server where UCS 
Server databases reside. 

– Advanced – to view the advanced LDAP Setting window. 
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3.2.3.4.6 Video Presentation Mode 

 
 

 Master Send Frame – maximum number of frames that can be sent by the organizer. 

 Master Receive Frame – maximum number of frames that can be sent by the participants. 

NOTE 
The organizer PC in presentation mode should have considerable CPU power to process video 
frames received from up to 32 users. Using higher frame rates requires higher CPU power to 
process the video frames. 
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3.3 View Menu Selection 
Selecting View shows the following selections:’ 

 
 

 View Selected User Detail Information – displays detail information window for selected 
user in the Presence or Log window. 

 Call Assistance – displays the Call Assistance window. 

 Restore Default Window – returns UCS Client main window to the default appearance. 

 Quick Call Control Bar – determines if the Quick Call Control Bar will be hidden or shown. 

 Phone Tab – determines if the Phone Tab will be hidden or shown. 

 Organization – determines if the Organization Tab will be hidden or shown (options set by 
Server Admin.). 

3.3.1 View Contact Detail 
When a contact is selected in the Presence or Log window, basic information about the 
selected contact will display along with an iconic view of the communication modes available.  
Icons for available communication modes are highlighted while modes not available are shaded.  
Icons and the represented communication are: 

 
 

 Start an IM session with selected user. 

 Send E-mail to selected user. 

 Make a call to the desktop phone of a selected user. 

 Make a call to the cell phone of a selected user. 

 Make a call to the office phone of a selected user. 

 Make a call to the home phone of a selected user. 

 Display other menus. 
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– Initiate File Send, Sharing, Web Push or Video call with the selected user. 

 
 

To send files to a selected contact, drag and drop the appropriate file from its folder window to 
the Contact Detail window. 

 
 

3.3.2 Call Assistance 
The Call Assistance bar is always shown on top of other desktop screens to allow instant voice 
communications. The bar is semi-transparent and may be dragged and dropped to an 
unobtrusive location on the desktop screen. 

 
 

Additionally, you may activate display of the Station LCD; right click on the Call Assistant and 
select ‘Display LCD’ to view the Station LCD display along with the Call Assistant. 
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3.4 Tools Menu Selection 
The Tools menu provides direct access to UCS Client collaboration, database and 
communication services.  Each of the Tools menu items can be accessed from other menus 
and is discussed further in other sections of this guide as noted below. 

  
 

 Call – displays the Call menu, refer to Section 8. 

 IM – displays the IM window, refer to Section 11.1. 

 File Send – displays the File Send window, refer to Section 11.2. 

 Sharing – contains the selections for Application Sharing, Desktop Sharing, Whiteboard, 
Web Push, refer to Section 11.3 and 11.4. 

 SMS – displays the SMS window, refer to section 11.6  

 Schedule – displays the Schedule window, refer to Section 9.  

 Video – contains selections for Video (Normal Mode), and Video (Presentation Mode), refer 
to Section 11.5. 

 Chat Room – displays the Chat Room window, refer to Section 11.1.2. 

 IM Log – displays the IM Log window, refer to Section 6.3. 

 Import Contacts – import the contents from other contact database tools, refer to Section 
6.1.1.4. 

 Export Contacts – export the contents of the user’s contacts to other database tools, refer 
to Section 6.1.1.4. 

 Audio Conference – establish ad hoc conferences and manage conference rooms, refer to 
section 14. 

 Favorite Links – displays the Program & Web Link window. 
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3.5 Help Menu Selection 
The Help menu displays this user guide in PDF format and the About screen, which contains 
general information on the UCS Client application including the version and release date.  To 
display the user guide, Adobe Acrobat Reader, which is available from the Adobe web site, is 
required. 

  ►   

3.6 Tray Menu 
UCS Client places a short cut button in the right notification tray. Right clicking on the short cut 
displays one of two menus depending on the login state of the UCS Client. 

After Login 

 
 

 Open UCS Client – opens the UCS Client with the last displayed main window. 

 Tools – opens the Selected Member window to either ‘Make a call’ or ‘IM’. 

 Presence – opens the UCS Client with presence in the main window. 

 Logs – opens the UCS Client with the Logs window. 

 Set My Presence – change my presence, refer to Section 3.2.1. 

 Set My Phone Status – change my phone status, refer to Section 3.2.2. 

 Logout – log out of the UCS Client. 

 Exit – closes and exits the UCS Client. 
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Before Login 

 
 

 Open UCS Client – opens the UCS Client Login window. 

 Login – opens the UCS Client Login window. 

 Exit – closes and exits the UCS Client. 
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Chapter 4  
Message & Status Bar 

The Message icons for Voice Mail, SMS, Notes and Missed calls are shown at the right above 
the main window.  These icons indicate the number of unheard or unread messages, and give 
access to Voice Mail and message log windows.  

 

4.1 Message Icons 
The Message icons for Voice Mail, SMS, Notes and Missed calls are shown at the right above 
the main window. These icons indicate the number of unheard or unread messages, and give 
access to Voice Mail and message log windows.  

 
 

Press the desired message icon: 

 Parked Calls 

 Voice mail, refer to Section 4.1.1. 

 SMS, refer to Section 4.1.2. 

 Notes, refer to Section 4.1.3. 

 Missed Calls, refer to Section 4.1.4 
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4.1.1 Voice Mail 
The Voice Mail selection will access your assigned Voice mail server.  If you have multiple 
Voice mail servers and ‘Set the VM as Default’ is checked, the VM Selection window appears 
and you may select a VM server.  If “Set the VM as Default’ is not checked, the VM Selection 
window is available from the Call menu under the Tools main menu.  The Voice mail icon is 
displayed even though no Voice mail server is assigned to your station. 

 

4.1.2 SMS 
Up to ten (10) incoming SMS messages are stored in the iPECS.  The SMS message log is 
retrieved from iPECS by clicking the SMS icon in the UCS Client.  The main window then 
displays a log of the SMS messages. 

 
 

4.1.3 Notes 
Notes left by other users are retrieved from the UCS Server by clicking on the Notes icon in the 
UCS Client. The main window displays all received Notes. 
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4.1.4 Missed Calls 
Missed call information is displayed by clicking the Missed Calls icon.  The main window 
displays detailed logs for each missed call. 

 

4.2 Status Icons 
UCS Server monitors and displays your IM Presence, Phone and Video status icons, updating 
the icons automatically as your status changes. These icons on displayed on the right side of 
the “My Detailed Information’ area of the UCS Client window. In addition, the Presence and 
Phone icons can be used to modify your status as outline in Sections 3.2.1 and 3.2.2.  The 
Presence and Phone status can also be changed manually under the File selection of the Main 
menu.  Icons and the represented status are shown below. 

 
 

The Presence icons are: 
 : Offline 

 : Online 

 : Busy 

 : Away  

 : Be Right Back  

 : Out of Office 

 : In a Meeting 

 : DND 

 
The iPECS Phone status icons are: 
 : Idle 

 : Busy 

 : DND 

 : Call Forward 
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The Webcam status icons are: 
 : Offline 

 : Online 

 : Unavailable 
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Chapter 5  
My Detail Information 

You can view and modify the information in the ‘My Information’ window including today’s 
message, ‘My picture’ and the day’s appointments. In addition, your detailed information and 
password can be modified using the ‘My Information’ window.  

5.1 Setting My Picture 
The ‘My Information’ window includes a user-defined picture shown to other users in the Shared 
Directory and during certain IM sessions. The picture must be a .jpeg file, which will be resized 
to fit in the ‘My Picture’ area. 

 
To change the picture: 

１. Select the Picture Change button (down arrow). 

２. From the Windows file directory, locate and select the desired file. 

３. Click Open to apply the selection as the My Picture file. 

 

5.2 My Information and Password – (P) 
The UCS Client sends the User ID and Password to the iPECS system and UCS Server during 
login to authenticate the client.  The password can be changed from the My Information 
window or in the UC server Web Admin.  This function is supported in Premium license. 

NOTE 
In cases where Single Sign-On is set by Web Admin, [Change Password] menu will be disabled 
because exchange server sets user’s password automatically. 
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To change your password: 
１. Click on the My Picture to display your detailed information, then select [My Information] 

 
２. Select Change Password, the Change Password window displays. 

３. Enter the current password. 

 

４. Enter and confirm the desired password in the New Password and Confirm Password boxes. 

５. Select OK to save the change. 

NOTE 
The new password length must be equal to or greater than the minimum password length 
permitted by the UCS Administrator. 

 

To change My Information: 
１. Click on the My Picture to display your detailed information, then select [My Information] 

２. Edit contents of any editable field.  

 Editable fields are set by UCS Administrator. 

３. Press OK to save the changes. 
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5.3 User Defined Message 
You can write a message to display to other UCS Clients. 

To post your message:  
１. Input the message. 

 

２. Press Enter button on the PC, the message is displayed in bold font. 

5.4 Today’s Appointments – (P) 
My Information window includes a display of today’s appointments.  The time and name of the 
next appointment is shown in the window.  If there is more than one appointment, the down 
arrow button will display all appointments for the day.  In addition, appointments can be viewed, 
added or modified as discussed in Section 10 by clicking on the calendar to the right of the 
appointment display.   This function is supported in UCS Premium license. 
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Chapter 6  
Main Window Views 

The main window has three views (Presence, Phone, Logs) selectable with the tabs at the top 
of the window.  The Phone tab can be hidden, see Section 3.2.3.2. 

6.1 Presence Window Introduction 
The Presence window displays the status of contacts you select from one of two directories 
available with UCS.  The contacts in the Shared directory, which is managed by the UCS 
Administrator, are available to all users.  You also have access to contacts in a second 
directory called the Private User directory.  A separate Private User directory, which is 
managed by you and stored in the UCS Client PC, is available to you only.  The Presence 
window displays the status of the UCS Client, iPECS desktop phone, Webcam, Schedule and 
Remote Monitoring for listed contacts using icons.  For contacts not monitored by UCS, for 
example external Shared or Private User contacts, no status is available to UCS and a single 
icon displays their status.  The tool and status icons employed in the Presence window are 
shown below. 

 
 

The tool icons are: 
 : Add Contact 

 : Add Group 

Phone & 
Call Log  
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The Presence icons are: 
 : Offline 

 : Online 

 : Busy 

 : Away  

 : Be Right Back  

 : Out of Office 

 : In a Meeting 

 : DND 

 : Phone User (Presence status is blank) 

As in picture below, Phone user’s status is blank because there is no presence status for phone 
user and Phone image is used for distinguishing Phone users from UCS users. 

 
 

The iPECS Phone status icons are: 
 : Idle 

 : Busy 

 : DND 

 : Call Forward 

 
The Webcam status icons are: 
 : Offline 

 : Online 

 : Offline 

 : Online 

 

The Schedule status icon ( ) displays after the contact if the Contact has established a 
‘Today’s Schedule’. 

The Remote Monitoring status icon ( ) displays after the contact if the Remote Monitoring has 
been allowed by the monitored user.  

When a contact is selected, the contact’s information displays in the ‘Selected Contact’ window 
just below the Presence window, refer to Section 6.5.  In addition, icons are available in the 
window for each available communication mode.  
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The Presence window can be used to establish communication with the listed contacts.  By 
right clicking the mouse on a contact, one of four collaboration and management popup menus 
will display.  The popup displayed is based on status and type of the contact as below. 

 
►ONLINE POP-UP  ►OFFLINE POP-UP ►NON-UCS POP-UP ►PRIVATE USER POP-UP 

  
 

From these menus, you may select Make a Call to call the contact, initiate a collaborative 
session (IM, File Send, Sharing, Web Push, etc., see section 11) with the contact, block the 
selected user from receiving you presence and status information (select Block), remove the 
contact from your Presence window (Delete User) or view detail contact information (Detail 
Information).  In addition, for offline contacts, you may Leave a Note.  The following 
describes menu items: 

 Make a Call – places a call to the selected contact 

 Scheduled Dial – registers a Schedule Dial to the selected contact 

 Start a Video Call – Video with call (Normal/Presentation Mode) 

 IM – starts IM session to the selected contact 

 File Send – starts File Send to the selected contact 

 Sharing – Initiates a sharing session with the selected contact (Application Sharing/Desktop 
Sharing/Whiteboard/Web Push) 

 Clicking popup item – starts one click sharing session with the selected contact and 
includes selected item. 

 Video – starts a Video call to the selected contact 

 SMS – sends an SMS to the selected contact 

 Email – sends an Email to the selected contact 

 Leave a Note – leaves a note to the selected offline contact 
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 Block – blocks the selected user from receiving your presence 

 Detail Information – opens the selected user’s detail information box 

 Today’s Schedule Info – displays the selected user’s today’s schedule information 

 Move Selected User to – moves the selected user to another group 

 Delete User – deletes the selected user from the Presence window 

 Delete All Private Users – deletes all private users from the Presence window 

In addition to selecting a single contact, you can select multiple contacts or grouped contacts 
for activation of a function from the menu.  To select multiple contacts: 

１. Select a contact. 

２. Select additional users using the mouse and Ctrl or Shift key. 

３. Right-click your mouse on the contact records and selects the appropriate function in the 
popup menu.  

 
 

NOTE. 
If more than five (5) online users are selected, the offline popup menu is displayed in place of 
the online menu. Certain functions available from the online popup are not available to more 
than six (6) users. For example, the maximum number of users in a Video Conference is six, 
you and 5 other users. 
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► MULTI SELECT     ► MULTI SELECT  
ONLINE POP-UP      OFFLINE POP-UP 

 
 

To select contacts in a group: 
１. Select a group. 

２. Right-click on the contact records then select a function from the popup menu displayed. 

 
 

► Group Offline Menu 

 
The following is a brief description of menu items available. 

 Start Group Call – places a call to the selected group of contacts 

 Start Video Group Call – places a video call to the selected group contacts 

 Delete All Selected Users – deletes the selected users from the Presence window 

 Delete All Users in this group – deletes all users in the selected group from the Presence 
window 
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To Leave a Note to an offline contact: 

１. Right-click on a contact record. 

２. Select Leave a Note (only available for offline contacts). 

３. Enter your note in the Leave a Note window, maximum 100 characters. 

 

４. Click OK to send the Note. 

 
You can customize the Presence window appearance with the View selection. 

 All – displays all Presence contacts 

 Share – displays only Shared contacts 

 Online – displays only online contacts 

 Blocked – displays only blocked contacts 

 Private – displays only private contacts 

 
Also, you can define the sorting order of contacts in the Presence window with the Sort 
selection. 

 IM – sort by IM status 

 Phone – sort by Phone status 

 Name – sort alphabetically by Contact name 

6.1.1 Managing the Presence Window 
The Presence window has a number of tools to manage contacts, groups, appearance and 
order of contacts. 

 

6.1.1.1 Adding and Deleting Contacts 
Contacts in the Shared directory may be added to or deleted from the Presence window.  The 
Presence window also displays the Private directory and contacts may be added or deleted.  
The Shared contacts directory is stored in the UC server and is managed by your iPECS 
Administrator. 
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You manage the Private directory, which includes the following information for each contact: 

 Name and Nickname 

 Cellular Phone 

 Office Phone, Name, Department, FAX and Office Address 

 Home Telephone, Address and Email.  

NOTE 
When adding a Private User contact, the contact name and Office Phone are required, the 
remaining fields are optional. 

 
To add a contact from the Shared directory: 

１. Select the Add Contact icon ( ) in the upper left side of the window. 

２. In the Select User Type window, select Add Shared User. 

 

３. In the Add Shared User window, select the field to search using the drop-down menu. 
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４. Enter the appropriate text to search within the field. 

５. Click Search to display matching records. 

６. Select the user to add and click Add; the contact record is displayed in the Not Assigned Group 
in the Presence window. 

To add a new Private User: 
１. Select the Add Contact icon in the upper left side of the window. 

２. In the Select User Type window, select Add Private User. 

 

３. In the Add Private User window enter the contact information (Name and Office Phone are the 
required fields). 

 

４. Click OK to store and display the contact record.  The new contact is shown under the Private 
group and stored in the Private User directory. 

 
To delete a contact from the Presence window: 

１. Right-click on the desired record. 

２. In the popup menu, select Delete User. 

３. Click ‘Yes’ to confirm the deletion. 

NOTE 
Deleting a Private contact from the Presence window also deletes the record from the Private 
User directory.  Deleting a Shared contact only removes the record from your Presence 
window. 
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You may also view all the information on the contact. To view Detailed Information: 

１. Right-click over the desired record, 

２. Select Detail Information to display the contact’s Detail Information screen.  The information 
for a Shared user includes the user’s picture and schedule for the day.  The information in the 
window is the same as the Add Private User window shown above. 

 

 

6.1.1.2 Organizing Contacts by Group – (P) 
For easier management, the Presence contact list can be divided into groups.  Groups can be 
added, deleted, renamed and contacts moved from one group to another.  Initially, all Shared 
contacts are placed in the Not Assigned Group and Private contacts are displayed in the Private 
group.   This function is supported in UCS Premium license. 
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To add a group: 
１. Select the Add Group icon. 

２. Type the new group name desired. 

 

３. Click OK to add the new group. 

 
To rename a group: 

１. Right-click on the desired group, the pop-up menu will display. 

２. Select Rename Selected Group. 

 

３. Enter the new group name and click OK button. 

 
To delete group: 

１. Right-click on the desired group, the popup menu will display. 

２. Select Delete Selected Group. 

NOTE 
All contacts must be removed from the group before it can be deleted.  Note the predefined 
Not Assigned Group cannot be deleted. 

 

To move a user to another group: 
１. Right-click on the desired user, the pop-up menu will display. 

２. Select Move Selected user to. 

３. Select the group where the contact is to be moved, 

OR 

４. Drag and drop the user name to the desired group. 
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6.1.1.3 Searching the Presence Window 
You may query the Presence window to locate a contact quickly.  The UCS Client will search 
the contacts listed in the window.  Text entered in the search box is compared to the Name, 
Today’s message and Desktop Phone 1 fields in each record.  If no matching records are 
found, you can extend the search to all records in the Shared directory or, if enabled, in the 
LDAP database. 

 
 

NOTE 
[Search Speed Dial] function is supported in UCP/eMG system. 

 
 

To search users in the Presence window: 
１. Enter the appropriate text to search. 

 
 If no matching records are found, extend the search to the Shared or LDAP database: 

２. Select Search Shared User, Search LDAP User or Search Speed Dial. 
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 The search results window displays. 

３. From the results window, right click to display the actions popup menu as shown below. 

► SHARED USER POP-UP  ► LDAP POP-UP 
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6.1.1.3.1 Search Shared User 
The Search Shared User window shows IM status, phone status, Webcam status, User ID, 
Name, Desktop Phone, Cellular Phone, Email and schedule status and features of the 
Presence window. 

 

NOTE 
Presence status in the Shared and LDAP windows does not automatically update, the display 
indicates the status when the user queried the database. 

 
If the number of queried users exceeds 100, the first 100 results will be shown, and any other 
results will be shown on subsequent pages. 

\ 

6.1.1.4 Managing the Private User Directory 
The Private User directory is a list of contacts you can enter or import from an external Contacts 
database.  When initially entered, these contacts are listed in the Private group of the 
Presence window.  In addition to adding and deleting a Private User contact, these contacts 
can be edited, all Private User contacts can be deleted and the contacts imported or exported 
to databases including Outlook, Excel, Goldmine or ACT!. 
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To edit a user record: 
１. Right-click on a record; the pop-up menu will display. 

２. Select Edit User from the popup menu. 

３. Modify the user’s information. 

４. Click OK to save. 

 
To delete all the Private User contact records: 

１. Right click on any contact or group. 

２. Select Delete All Private Users from the popup menu. 

３. Click Yes to confirm. 
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6.1.1.4.1 Importing and Exporting Contacts 
Private User contacts can be imported from and exported to other contact databases such as 
Outlook, ACT!, Goldmine and Excel.  When contacts are imported, the contact records are 
placed in the Private group and can be moved to a different group as desired. 

To import contacts from ACT!, Goldmine, Excel or Phontage: 
１. Select Import Contacts from the Tools menu. 

 

２. Select the database type. 

３. After importing, the Import Result window displays and the imported contacts are displayed in 
the Private group. 

To import contacts from Outlook: 
１. Select Import Contacts from the Tools menu. 

２. Select Outlook. 

３. Select the Outlook contact folder, the Outlook access popup displays. 
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４. Check Allow access for, select a time and click Yes. 

 

５. The Import Result window displays and the imported contacts are displayed in the Private 
group. 

NOTE 
If No is selected in the Outlook access popup window, the import will fail and you will receive an 
‘Unknown Error’ notification. 

 
 

To import contacts from a CSV file: 
１. Select Import Contacts from the Tools menu. 

２. Select CSV. 

３. Select the CSV file to import.  The CSV Field Mapping Table window is shown. 

 

４. Arrange the CSV Fields. 

５. Uncheck fields not to import. 

６. Click the Import button. 
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To export contacts to ACT!, Goldmine, Excel, or CSV: 
１. Select Export Contacts from the Tools menu. 

２. In the popup Notification window, select Yes to include Shared User contacts or No to export 
Private User contacts only. 

３. Select the database type.  The export process starts and a notification window appears when 
completed. 

 
 

NOTE 
When using Excel reporting, the Excel program must be closed before starting to export data.  
If the program is not closed, the user will receive a popup message requesting Excel to be 
closed.  

 

 
To export contacts to Outlook: 

１. Select Export Contacts from the Tools menu. 

２. In the popup Notification window, select Yes to include Shared User contacts or No to export 
Private User contacts only. 

３. Select Outlook for the database type. 

４. Select the desired Outlook contact folder, Outlook access popup displays. 

５. Check Allow access for, select time, and click Yes.  The export process starts; a notification 
window displays when completed. The export process starts; a notification window displays 
when completed. 
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6.2 Phone Window View 
With the Phone mode enabled, refer to see Section 3.2.3.2, you have access to all of the 
iPECS system features as well as the features available to traditional iPECS IP Phones, with 
the few exceptions based on the differences discussed below.  The fixed feature keys operate 
in the same manner as in the iPECS IP Phones except the mouse is used to select dial pad and 
feature buttons.  For operation of the features, refer to the iPECS IP Phone User Guide.  

 
 

With the exception of the following User Programming items, the Phone window screen allows 
complete access to all the features and resources of the iPECS host system.  

 Station Answer mode – only Privacy for the Station Answer mode; Intercom Call Announce 
is not supported for the UCS Client. 

 Station Ring Download – UCS Client users can change the ring tone files stored in the 
iPECS UCS Client folder; ring tone files cannot be downloaded from the iPECS system. 

 Audio source control – UCS has a single audio path, and cannot support the dual path 
(headset and speaker) controls available with the traditional iPECS IP Phone. 

There are three Speaker volume settings for ring, internal call volume, and external call volume; 
the three volumes are saved and retrieved according to phone status. 
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6.3 Logs Window 
The Logs window displays the log of UCS services used by the UCS Client.  The log identifies 
the service type, name of connected party and time the service was employed.  These logs are 
stored on the UCS Client PC and can be searched or archived as a backup file in the UCS 
Client folder.   

 
 

In addition, by right clicking on a record, the popup menu similar to the Presence popup is 
displayed, see Section 6.1. 

Services logged are: 
 Call (Incoming, Outgoing, Conference Room) 

 Instant Messaging (IM) 

 Application Sharing 

 Desktop Sharing 

 Whiteboard 

 Video 

 Presentation 

 Remote Monitoring (Requesting) 

 Remote Monitoring (Be requested) 

 Web Push 

 File Send 

 SMS 

 Note 

 Missed Call 

 Memo 
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To search the Logs window: 
１. Select the Service Type from the drop-down menu. 

２. Enter the appropriate text to search. 

 

NOTE 
If more than 2000 records are stored, when you login a Backup window will display indicating 
the Logs window should be archived.  This is required to minimize any effect a large number of 
logs may have on performance of the UCS Client and other Windows applications.  The 
archive file is named and saved to a backup directory in the UCS client folder.  The backup file 
name includes the date as in the following example, 20080325143309092.xml 
To view the backup file, double click the file name in the UCS Client folder. The file is displayed 
with the default browser as below. 
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6.4 Selected Contact Window 
The Selected Contact window displays immediately below the main window and provides basic 
information about the highlighted contact.  The window includes icons to establish a 
collaborative session with the contact.  Highlighted icons indicate the communication modes 
available to the contact.  Selecting an icon initiates the communication.  The Selected Contact 
window can be disabled if more space is desired in the main window, see Section 3.3.1. 

 
 

6.5 Organization Window – (P) 
The Organization window displays the Organization Chart from the UCS Server in a split screen 
showing the Organization hierarchy tree and organization members.  Members are shown in a 
tabular format with presence status.  Tools allow you to customize the view with the 
organization tree to the left, right, above or below the member table.  In addition, the various 
presence states (IM, phone, video, etc.) can be eliminated from the view and a sorting order for 
the members (IM, Phone or Name) can be selected.  Manual and immediate refresh buttons 
(     permit the user to refresh the display immediately or allow timed updates.  This 
function is supported in UCS Premium license. 

 
To use the Organization window, the Organization Chart must be established and use 
authorized by the iPECS UCS administrator. 

To view the Organization window: 
１. From the View menu, select Organization. 
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２. Logout of the UCS Client and log back in; the Organization tab will be shown in UCS Client 
automatically. 

6.5.1 Searching the Organization Chart 
A department may be selected to view all the users in a department.  In the upper right of the 
Organization window is the Search text entry box.  To search for a particular user, enter 
search characters in the box and matching entries will be shown in the Organization window.  
You may right click on a contact to receive popup menus as with the Presence window, Section 
6.1. 

 
 

NOTE 
The UCS Client searches for a match in the Name, Desktop Phone, User ID and Cellular Phone 
fields, in order. 

6.5.2 Window Appearance 
Tools in the Organization window allow the user to change the appearance of the window as 
well as the presence information shown for each contact.  

To modify the appearance:  
１. Select the Screen tool at the upper left. 

Ericsson-LG 
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２. From the Screen tool menu, select the desired screen orientation.  The Organization window 
will display with the orientation selected. 

 
 

To modify the presence information shown in the window, 
１. Select the Screen tool at the upper left of the window. 

２. From the Screen tool menu, select Customize Column View. 

３. In the popup menu, check the box in front of each item to display for the contacts. 

 
 

Ericsson-L

Ericsson-LG

Ericsson-L

Ericsson-LG

Top/Bottom View Bottom/Top View

Left/Right View Right/Left View
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To change the sorting of the window, 
１. Select the Screen tool at the upper left of the window. 

２. From the Screen tool menu, select Sort. 

３. In the popup menu, click the sorting column. 
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Chapter 7  
Quick Call Control Bar 

With the Quick Call Control Bar at the bottom of the main window, you can make and receive 
calls.  The text box displays the names and numbers from contacts in the Presence window or 
you may dial a number from the Simple dial pad popup.  This control bar consists of the 
Simple dial pad icon, drop down contact list, and Call and Speaker controls. 

7.1 Placing a call 
Placing a call from the Quick Call bar is quick and efficient. 

To place a call using the Simple dial pad popup: 
１. Launch the simple dial-pad popup using the dial pad icon. 

２. Click on digits to dial the number. The digits display in the pre-dial box. 

 

３. Press the Call button to place the call. 

To place a call using the drop down contact list (shows a list of contacts from 
the Presence window): 

１. Click on the drop down arrow to access the contact list.  

２. Click to select the desired contact.  

To end the call: 
１. Click on the speaker button. 

２. Calls can be placed from other applications while the UCS Client is active or minimized.  

 

Dial pad icon 
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To place a call from another application:  
１. Copy the desired digit string (Ctrl + C). 

２. Press the “Ctrl + Shift + D”. 

Or 

With the Call Assistant displayed, drag the mouse over a number while holding the right mouse 
button. 

7.2 Receiving a Call 
When a call is received, the phone will ‘ring’ and the selected caller id popup will appear.  The 
window shows the caller id delivered from the iPECS and the name associated from the 
Presence window.  If the UCS Client is minimized, the popup will display the incoming call 
information or the iPECS UCS Client icon in the Windows tray will flash to indicate the new call.  
In the latter case, iPECS UCS Client must be activated to answer the call.  

To answer a call with the UCS Client active:  
１. Click on the speaker (   ) button. 

 
To answer the call with the iPECS UCS Client minimized: 

１. From the Caller Id popup, click the Answer button. 

 
 

To end the call with the iPECS UCS Client minimized: 
１. Click the Reject button. 

Or 

Activate the UCS Client and click the Hangup button. 
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Chapter 8  
Tools Menu Call Features 

From the Tools menu of the main application, you can access the Call menu.  In this menu are 
tools designed to enhance group collaboration and simplify use of calling features. 

8.1 Scheduled Dial 
Scheduled Dialing permits you to enter a phone number for dialing at a later scheduled time.  
When the scheduled time is reached, the Confirm window appears, you must confirm before 
dialing will begin.  The Scheduled Dial window contains a list of the phone numbers and 
schedules entered.  The window includes icon tools to manage scheduled calls.  

 

To access the Scheduled Dial window: 
１. From the Tools menu, select Call. 

２. From the Call menu, select Scheduled Dial to display the window. 

To add or edit a Scheduled Dial: 
１. Click the Add or Edit icon on the Scheduled Dial window; the Scheduled Dial Manager popup 

appears. 

 



 

 
iPECS UCS Client for PC User Guide - Issue 4.7 91 

２. Enter the Name and Company. 

３. Enter or use the drop down menu and select a Phone number (required entry). 

４. Use the pull-down to schedule a Date & Time.  

５. Click OK to save. 

NOTE 
Each Scheduled Dial must have a unique scheduled time. Duplicate schedule times are not 
allowed. 

 
To delete an entry from the Scheduled Dial window: 

１. Select Delete or Delete All; confirm the record deletion. 

２. Click OK. 

When the scheduled time is reached, the Confirm window will appear.  You must confirm by 
selecting OK before dialing will begin.  You can select Snooze to delay the call. 
 

 

8.2 Recorded Call Playback  
The UCS Client allows you to record a conversation onto the client PC hard drive.  Recorded 
conversations can be reviewed after recording.  In addition, text or voice comments can be 
added to the recording and sent via email as attached .wav files.  Using the tool icons at the 
top of the Recorded Call window, you can delete, add a comment and E-mail recordings.  

Calls are recorded with controls in the Call View, see section 13.   

To playback a recorded call: 
３. From the Tools menu, select Call. 

４. From the Call menu, select Recorded Call to display the Recorded Call window. 

５. Select the desired recording. 

６. Use the reverse, play, pause, forward and stop playback icons to control the playback. 



 

 
92 iPECS UCS Client for PC User Guide - Issue 4.7 

8.3 Auto Call Recording 
When enabled in the iPECS system, conversations of the UCS Client and/or other iPECS users 
are recorded to the hard drive of the UCS Client PC.  Other stations in the system may be 
assigned to record conversations to the UCS Client, “3rd party recording”.  For proper 3rd 
party recording, the iPECS UCS Client must be idle. 

8.4 Flex Buttons 
The Flex Button window provides access to 48 Flex buttons.  Each button has a status icon, 
which displays the status of the CO Line or station associated with the button.  The button also 
displays a designation from the iPECS system database, such as CO 001, LOOP, etc.  Flex 
buttons of the UCS Client may be assigned to activate other iPECS system features such as 
dial a Station Speed Dial. 

 
 
To enter and assign a Station Speed Dial to a Flex button: 

１. Right click on an assigned Flex button. 

２. Select Set Attribute; the Flexible Button program screen will display. 

３. Enter the number to be dialed. 

４. Click the CO Call checkbox if the input number is not a station number. 

５. Enter an optional Description (display) label for the Flex button. 

６. Click the Save button. 

Status icon 
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NOTE 
If a Flex button is assigned for Paging, the UCS Client must be off-hook prior to selecting the 
Page button.  The UCS Client must be in the idle mode to assign a Flex button. 
When UCS Client’s Flex button is clicked with No Voice mode, Flex button of controlled hard 
phone will be worked.  

 
To Show Flex Button on login: 
For Flex Button to show on login, check Setting > Basic Action - [Show Flex Button on login]  

 

8.5 Voice Mail Server Selection – (P-CM) 
When multiple voice mail servers are associated with the UCS Client, the VM Selection window 
permits access to the various mail servers.  This function is supported in CM Premium 
license. 

 
 

NOTE 
A server can be selected as default, in which case this window is not shown when selecting the 
VM icon in the Message and Status icon tool bar. 

 

To access the VM Selection window: 
１. From the Tools menu, select Call. 

２. From the Call menu, select VM Selection to display the VM Selection window. 

３. Select the desired Voice Mail server from the drop down list. 
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8.6 Favorite Contacts 
Favorite Contacts allows you to call and transfer calls easily using the Call window. 

 
 

To add lists to Favorite Contacts: 
１. From the Tools menu, select Call > Favorite Contacts, the Select Member window will be 

shown. 

２. Select the desired Member(s) and press the Add button.  The contacts are added at the 
bottom of the Select Member window. 

8.7 Step Call 
Step Call allows the user to make calls to numbers from a contact list sequentially.  Users 
create a list of contacts for outbound calling, which can be added one-by-one or imported from 
a file where the file extension is ‘.scd’ or ‘.csv’. 
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To add contact(s): 
１. Click the Add button in the toolbar. 

２. Enter values into the edit box at the bottom of the Step Call Information window. 

To add contact(s) from a database: 
１. From the File menu, select Load Step Call Database. 

２. Select a Step Call Database. 

 

NOTE 
You can create a Step Call Database template file with a file extension of .csv (select File > 
Create a Template File). 

 
 

To add contact(s) from the Directory: 
１. From the File menu, select Add List from Directory, the Select Member window will be 

displayed. 

２. Select and add the desired contact(s) from the Select Member window. 

 
 

To make an outbound Step Call: 
１. Select a record in the outbound calling list. 

２. Press the Step Call Start button.   

３. The phone number of the selected record will be dialed. 

４. After the call is completed, the ‘Result’ and ‘Memo’ can be created; the interval between calls 

is set as shown. 

 Result input selections include: 

– Success:  

– Failure:  

 If a memo is saved, the     symbol will be displayed.  

 If             is pressed, the current time and user name will be entered automatically. 
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The next record on the list will be selected automatically.  

５. Step calling stops when the end of the calling list is reached, 

OR 

Step call can be stopped by pressing the                button. 

 
Alternate method for making a Step Call:  

１. Select a record from the outbound calling list. 

２. Press the Make a Call button             the call will be initiated. 

３. When the call is terminated, the user can enter the ‘Result’ and ‘Memo’, if necessary. 

 
To end a Step Call: 

１. Press the ‘Drop’ button           . 
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To create a Template File: 
１. From the File menu, select ‘Save the current List As…’. 

２. In the dialog box displayed, enter the desired file name and click on the OK button. 

３. A .csv file will be created with the designated name. 

To use the created Template file: 
１. Open the template with ‘Excel’, ‘Notepad’, etc. 

２. Enter values (Name, Company, Department and Phone number). 

３. When finished, click Save. 

４. Refer to Load Step Call Database (.scd, .csv) above to download the file. 

To save the current Calling List to a file: 
１. From the File menu, select ‘Save the current list As…’. 

 

２. In the dialog displayed, enter the desired file name. 

３. Click the OK button. 

 
To send the current Calling List to others: 

１. From the toolbar, select File Send. 

２. The UCS Client will save the current list as a temp file and attach it as the file to send in the 
File Send window. 

8.8 Call Memo 
The Call memo is designed for noting important information during a call so that the information 
can be referenced later.  The Call memo is retained in the recent Logs.  You can confirm and 
modify the memo in the Call Memo window.  The following methods can be used for activating 
the Call Memo window: 



 

 
98 iPECS UCS Client for PC User Guide - Issue 4.7 

 

１. From the File menu, select Setting > Call Popup > Show Call Memo Window Automatically. 

２. When a call is placed, the Call Memo window will automatically display. 

 
To activate the Call Memo window from the Call Tab: 

１. Click on the Call tab when on a call in UCS Client. 

２. Select ‘Add Call Memo’ or ‘Show call memo’. 

 
 Add Call memo –a call memo can be added with CID information. 

 Show Call memo – displays call memos already created. 

 
To activate a Call Memo window: 

１. If the option ‘Call pop-up’ is set and the UCS Client has Call memos regarding the current call, 

the Call Memo window can be activated by clicking on the icon at the bottom-right of the call 
pop-up window. 

NOTE 
Prior to closing the Call Memo window, the memo content is summarized on the screen. 
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To add a new Call Memo: 
１. Open the New Call Memo area. 

    Open this area.  

    Close this area. 

２. Enter the memo contents. 

３. Click on the Add button            . 

４. The saved memo will be located in recent Logs, and can be viewed when a call is placed from 
the UCS client. 

Using Scheduled Dial: 
１. Verify the ‘Scheduled Dial’ checkbox is checked    . 

２. Click on the Add button. 

NOTE 
The Scheduled dial will be activated with the user name, phone number and company name in 
the Call memo; saved Call memos also will display in this area, and can be modified or deleted. 

 
To modify a saved Call Memo: 

１. Click on a Call memo to be modified; the memo will be opened for editing. 

２. Modify the content. 

３. Changes will immediately update in the Call memo. 

To delete a registered Call Memo: 
１. Select the Call memo.  

２. Click on the Delete button         .  

The Call Memo tab can be used to manage comments from multiple users such as during a 
conference call.  Each user is separated with a tab in the Call Memo window. 

 

To Close a Tab: 
１. Click on the Close button,    , within the appropriate tab. 

NOTE  
If only one tab is open, the close button will not be visible. 

 

To select a different opened tab: 
１. Click on another tab to add Call memos for others on the call; changes are saved and 

displayed in a new Call Memo window. 
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8.9 ACD Manager – (UCP/eMG) 
ACD(Automatic Call Distribution) Manager supports functions which login/logout and on/off-duty 
on ACD Group.  This function is supported in UCP/eMG Premium license. 

 Display ACD Group list and user status 

 ACD Group login/logout 

 ACD Group on/off duty 

NOTE  
For ucs user to use ACD function, below settings are needed: 
1) In case of UCS Standard License, [UCS ACD USE] option should be set to ON. You can find 
[UCS ACD USE] option in Unified Web Admin – PGM112. 
2) In case of UCS Premium License, [Allow ACD Logon] option should be checked. You can 
find [Allow ACD Logon] option in UCS Server Web Admin – Use Feature Permission. 

 
Display ACD Group list and user status:  

  ▶  

１. Click Tools > ACD menu. 

２. ACD Group list is displayed on ACD Manager. 

 ACD Group status 

– Logout ( ): user is a logout status in ACD Group. 

– On-Duty ( ): user is a login/on-duty status in ACD Group. 

– Off-Duty ( ): user is a login/off-duty status in ACD Group. 
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ACD Group Login/ Logout:  
１. Select ACD Group on ACD Group list, then click Login button. 

 

２. ACD Group status is changed into On-Duty status like below. 

 
 
 

ACD Group On/ Off-duty:  
１. Select Off-Duty Reason Code, then click Off duty button. 

 

２. ACD Group status is changed into Off duty status. 
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Chapter 9  
Scheduling Appointments – (P) 

UCS user can view UCS schedule, Outlook schedule and Exchange link server’s schedule. 
When Exchange link server is used, Outlook schedule will not synchronize with UCS Client. For 
UCS user to use Outlook schedule rather than Exchange link server schedule, in UCS Server 
WebAdmin, Use “Exchange Link Server” checkbox of Exchange Link Server must be 
unchecked. 

Please refer to UCS Server manual to configure Exchange Link Server settings in more detail.  
 This function is supported in UCS Premium license. 

In the Schedule window, you can view, add and modify scheduled appointments.  
Appointments can be viewable by and E-mailed to other UCS Client users.  Appointments are 
displayed in the Schedule window, which is divided into 4 main components.  At the top of the 
window are the appointment management tools.  In the upper right is the monthly calendar, 
used to select appointment dates.  In the right left is the folder selection area used to select 
appointment folders to display in the Appointment window.  Finally, to the right of the 
Appointment window displays the summary of the day’s appointments. 

 

The Schedule window can be accessed from the main application Tools menu or by clicking on 
the calendar icon to the right side of the My Detail Information. 

  ▶   
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To synchronize Exchange link server’s schedule with UCS Client, type Exchange Server’s User 
ID and Password, then click save button. If user is authenticated, Exchange link server’s 
schedule will be synchronized with UCS Client. 

NOTE 
In cases where Single Sign-On is set by Web Admin, [Exchange Server Setting] menu will not 
appear because exchange server sets user’s password automatically. 

 

9.1 Managing Appointments 
You can add, modify, delete and copy your private appointments or shared schedule 
appointments in the Schedule Item window.  For your private schedules, you have all access 
rights to read, add, modify, delete and copy appointments.  For shared schedules, you can 
read all appointments and may have the authority to add, edit and delete Shared schedules as 
well as your private schedules.  In this window, the appointment is identified, scheduled and 
other users identified for notification.  In addition, a location and meeting content can be 
defined. 

To add an appointment:  
１. Select a date in the monthly calendar and click on the Add icon to display the Schedule Item - 

New window. 

２. In the Schedule Item window, complete all required fields. 
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 The Subject and Location fields can be a maximum of 255 characters. 

 Contents field can be a maximum of 450 characters. 

 Up to 20 attendees can be listed. Each attendee must have unique E-mail address.  

３. Set the action for automatic My Presence update for this appointment.  UCS Client will change 
and return My Presence to the status selected from the ‘My Presence for an Appointment’ and 
‘My Presence After Expired’ fields.  

４. Click OK; the new schedule will be displayed on the calendar. 

If the ‘Send Email Now?’ box is checked, the schedule is added and your default E-mail client 
opens with the attendees listed as receivers and the schedule attached.  If MS Outlook is set 
as the default E-mail client, ‘New appointment’ is displayed instead of ‘New email’. 

NOTE 
When there are several appointments that change My Presence at one time, the lower 
schedule in the Today’s appointments list has higher priority. 

 

Other UCS Client users can view your private schedules when you allow it by checking the 
“Open This Schedule to All Shared Users” box.  If you check this box, other UCS Client users 
can view your schedule and use it for presence information.  If the date of the appointment is 
today, your presence members can see that you have an appointment today as shown. 

You can allow other UCS Client users to view all your private schedules by checking the popup 
menu of your private schedule folder. 

 
If you want to arrange the schedule with attendees, click the Others button, a popup menu 
appears where you can start an IM session, Make a Call or check attendee schedules. 

 
To view an attendee schedules: 

１. Click the Add icon. 

２. Select Attendees for the schedule using the Select Member window. 
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３. Click the icon of another user; the popup menu will display. 

４. Click on a particular Attendee’s Schedule Viewer; the Viewer will display. 

５. If the start date and end date of the appointment are the same date, the window will show the 

day’s schedule of all attendees. Otherwise, it will show the day period schedule. 

 
To edit a schedule: 

１. Double click on the appointment in the Appointment window or select the appointment and click 
the highlighted Edit icon. 

２. Select the Edit icon button to display the Appointment window 

３. Modify the information in the window, see Adding an appointment above. 

４. Select OK, the modified appointment is displayed in the appointment list. 

NOTE 
When you edit an appointment that changes My Presence, you cannot select options from [My 
Presence for an Appointment] and [My Presence After Expired] drop-down list. 

 

To delete an appointment: 
１. Select the appointment from the Appointment window; if you have permission to delete the 

appointment the Delete icon will highlight. 

２. Click the highlighted Delete icon. 

３. Confirm to complete the deletion. 
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NOTE 
When you delete the appointment that changes My Presence, a confirmation window will 
display.  If you click the ‘Yes’ button, My Presence will be changed to ‘My Presence After 
Expired’ for the appointment. 

 
To copy a schedule to another date: 

１. Select the appointment from the Appointment window; if you have permission to edit the 
appointment the Copy icon will highlight. 

２. Select the highlighted Copy icon to display the Copy Schedule popup. 

３. Input any appointment edits and select new dates; the start and end dates and time are 
required fields. 

４. Select OK, to copy the appointment. 

NOTE 
If the difference between start and end date exceeds 7 days or if the range includes selected 
appointment dates, an error message displays. 

 

An ICR scenario can be added to a schedule to be used as needed for routing incoming calls at 
designated times. 

To add an ICR scenario for a schedule: 
１. Right-click on an appointment where the ICR scenario will be added. 

２. Select Add ICR Scenario; the ICR Wizard window will display. 

３. Enter Scenario Name and assign a scenario destination (refer to Section 10.4.5). 

４. Click on the OK button. 

To remove an ICR scenario from a schedule: 
１. Right-click on the appointment containing the ICR scenario. 

２. Select Remove ICR Scenario. 

３. Click to confirm the deletion. 

9.2 Folder List Display 
iPECS UCS Server maintains two lists of schedule folders, a shared schedule and your private 
schedule folders.  Schedules in the shared folder are managed in the UCS Web Administration 
by allowed users only.  Schedules in My Folder are your private schedules, which you maintain 
and manage.  Appointments from the selected folders are shown in the Appointment window.  
To select a folder check the box next to the folder name.  For each day, the window shows the 
appointments for all checked folders organized by date.  The list for each date can be 
minimized or expanded to display the summary. 
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9.3 Importing and Exporting the Calendar 
The appointments for the current month contained in a schedule folder and displayed in the 
calendar can be imported from or exported to Outlook.  If you want to import or export 
schedules for other months, simply change the month displayed in the Monthly calendar.  
Items contained in an unchecked schedule folder cannot be imported or exported.  Shared 
schedules not managed by you cannot be imported to or from your shared schedule folder. 

To import a schedule: 
１. Right-click on a checked schedule folder. 

２. Select Import From Outlook. 

３. Select the Outlook schedule folder to import and click OK; the Import from Outlook window will 
display.  

NOTE 
The Recurring column indicates that it is a recurring appointment. 

 

４. Select each checkbox for the schedules you want to import. 

５. Click on the Open checkbox of other UCS Client schedules that you want to view. 

NOTE 
If ‘Open All Schedule to Shared Users’ is unchecked in the personal schedule settings, the 
‘Open’ column of Import from Outlook will not appear. 

６. Set the action for automatic My Presence change for this appointment.  The UCS Client will 
change and return the My Presence selected from the Presence Update and When Expired 
drop-down list.  When finished making selections, click Import. 

７. The Import status displays in the Result column of the Import from Outlook window. 

NOTE 
If imported appointments contain text in HTML or Rich Text format, the text will be displayed in 
plain text format. 

 

To export the contents to Outlook: 
１. Right-click on the checked schedule folder that will be exported. 

２. Click Export To Outlook; the Export To Outlook window displays. 

３. Click on the checkbox for the schedules to export. 
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４. When finished, click the Export button; the Folder Selection window displays. 

５. Click on the target Outlook calendar folder to receive the export. 

６. Click OK to export the schedule, updating Outlook schedules. 

７. Export status displays in the Result column on the Export to Outlook window. 

NOTE 
Recurring appointments cannot be exported to Outlook because of the possibility of conflict with 
existing appointments. 

9.4 View Other UCS Client User Schedules 
You can check other UCS Client user schedules if the schedules are enabled for viewing by 
checking the ‘Open This Schedule to All Shared Users’ box.  To find UCS Client Schedules 
available, click on all selections: Presence, Organization, Logs and Phone windows in the main 
window or Search Shared User window. 

 

To view other UCS Client user schedules: 
１. Right-click on a contact’s schedule. 

２. Select Schedule Info; the Schedule Info window will display. 

 

３. Select the month to view by navigating forward and backward from the current position using 
the arrow buttons in the upper-left part of the window. 

４. Select a date in the mini-calendar on the left side. 

５. Click on the schedule to view the schedule details. 

６. Click OK to close the window after viewing the schedule. 
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Chapter 10  
ICR (Individual Call Routing) Window – (P) 

With iPECS UCS Client, you can establish scenarios to route incoming calls.  Each scenario 
defines rules to route incoming calls, time, day of week, date and caller ID to a destination you 
define.  Up to 10 scenarios can be established using the UCS Client ICR Wizard and the 
relative priority of each can be set.  You can select another UCS Client user as an Agent, who 
is then able to view and modify your scenarios.  When an incoming call is received, the iPECS 
notifies the UCS Server, which queries your ICR scenarios.  iPECS UCS Server will compare 
the incoming call parameters to those of the scenarios.  The call is then routed to the 
destination in the matching scenario with the highest priority.  This function is supported in 
UCS Premium license. 

 
The ICR Scenario window consists of three (3) major components: the User list on the left the 
Scenario and Summary screen on the right and the ICR icon tools at the top. 

To access the ICR window: 
１. Click Set My Phone Status from the File menu or the Phone status icon from the main window. 

２. Select Call Forward (ICR) from the menu. 

 
The following sections discuss how to establish and activate ICR scenarios. 
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10.1 ICR User List 
The User list, left side of the window, displays a list of scenarios accessible by you.  In addition 
to your own scenarios (default=Myself), you may be the registered as an Agent for other UCS 
users which permits you access to their scenarios.  Selecting a user from the list displays the 
corresponding scenarios. 

 

NOTE 

The  icon represents your scenario list and the  icon represents scenarios of users that 
registered you as an agent. 

10.2 Scenario & Summary Screen 
The Scenario & Summary window is a list of scenarios for the selected user and a summary of 
the call parameters for the scenario.  In this screen, the priority of the scenario can be adjusted 
with the up/down arrows.  The scenario listing includes: 

 Act – check box shows the status of the scenario (checked is active). 

 Index – defines the priority of the scenario. 

 Scenario Name – name assigned to the scenario. 

 Comment – timing status of the scenario: 

– Effective – timing of scenario is active or future, 

– Expired – timing of scenario has expired. 

 Holiday – indicates the scenario is for a holiday schedule. 

 Schedule – indicates the scenario is from your schedule 

The Scenario Summary at the lower part of the window displays the call parameters for the 
highlighted scenario: 

 Caller ID – Caller ID or Phone number that applies to the scenario. 

 Date & Time – the day, date and time to apply the scenario. 

 Destination – the destination User ID or Phone number. 

 IM Presence Condition – the IM presence state that applies to the scenario. 
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To adjust the priority of a scenario: 
１. Select a scenario in the list. 

２. Select Up/Down arrows to move the scenario in the list. 

 

３. Click Save to store the new priorities. 

10.3 ICR Icon Tools 
The ICR tools are used to manage the User Scenarios.  Icons refresh the ICR window and 
save, add, or edit scenarios.  Using the CFWD icon, you can forward your traditional iPECS 
terminal using a scenario.  Finally, with the My Agent icon, you can register or delete Agent 
definitions.  The following list identifies the icons, and provides a reference for more detailed 
information on operation of the icons (as applicable).  

 

         refreshes the user list (refer to Section 10.1). 

       refreshes the displayed scenario list. 

     saves the scenario. 

     adds a new scenario (refer to section 10.4). 

     edits the selected scenario (refer to section 10.4). 

         activates ICR Call Forward for the user’s iPECS terminal (refer to section 10.5). 

           registers or deletes agent (refer to section 10.6). 

10.4 ICR Wizard 
The ICR Wizard guides you through setting the parameters for a scenario.  In the wizard, you 
will assign a name, the Caller IDs that apply to the scenario, the scenario timing and the 
destination(s) to receive the call. 
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To access the wizard, select Add or Edit from the ICR Scenario List window or select from the 
popup Scenario menu (refer to Section 10.7).  

 

10.4.1 Entering a Scenario Name 
A Scenario Name with the current date and time is automatically generated when Add is 
selected.  The name can be modified at any time. 

To add scenario name: 
１. Enter a name in the Scenario Name box. 
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10.4.2 Defining the Scenario Caller ID 
Each Scenario applies to all calls, only calls from specific Callers, or another UCS Client.  Your 
Private directory or the UCS Shared directory can be searched to select callers, or you may 
directly enter Caller IDs that are subject to the Scenario routing. 

 
To apply the Scenario to all calls: 

１. Select the All call button. 

 
To search both the Presence and Shared directory: 

１. Select the Select Call(s) button. 

 

２. Click on the Spyglass search icon; the Select Member window displays. 

３. Select members to add. 

４. Click OK to add the member. 

To enter a specific number: 
１. Enter a number in the Call Number to Add box. 

２. Select the Add icon to add the number to the Caller Id list. 

 

 

To remove a Caller ID from the list: 
１. Highlight the desired Caller Id(s) by clicking on each. 
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２. Select the Delete icon. 

 

10.4.3 Setting the Scenario Timing 
You can specify a period (day, date, and time) when a Scenario will be effective.  You may 
select from several pre-defined periods, Work, Off Time, Holiday or Weekend, or define a timing 
specific to the scenario. 

To set Scenario timing: 
１. Select one of the predefined times or select Time and click Add button. 

 

２. Select the desired start and end times; check the days of the week for the scenario and select 
a start and end date. 

 

３. Select OK to save update. 
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10.4.4 Setting the IM Presence Condition 
You can specify the IM Presence when a Scenario will be effective.  You may make a scenario 
active regardless of IM Presence or select an IM Presence, Offline, Online, Busy, Away, Be 
Right Back, Out of Office or In a Meeting. 

To apply the IM Status to a Scenario: 
１. Select the All IM Status button. 

 
To apply the Scenario to a specific IM Status: 

１. Select the Selected IM Status button. 

２. Select an IM Presence (Offline, Online, Busy, Away, Be Right Back, Out of Office or In a 
Meeting) from drop-down Type menu. 

10.4.5 Assigning a Scenario Destination 
The Destination area establishes the routing of calls that meet the parameters of the scenario.  
Destinations include your cellular phone, home phone or office phone already registered.  
Additionally, your Private directory or the UCS Shared directories can be searched or you may 
directly enter a destination to receive the call. 

To search either the Private or UCS Shared directory: 
１. Click the Select Call(s) button. 

 

２. Click to Select User from the drop-down Type menu. 

３. Click Search. 

４. Select a destination from the Select Member window. 
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To enter a specific destination: 
１. Check the Select Call(s) button. 

２. Select a Type (Station, Hunt group, Offnet) from drop-down Type menu; a specific Hunt group 
can be selected from the list. 

３. Enter the appropriate number in the Selected Call(s) box. 

４. Click OK to save the new or modified scenario(s). 

 

 
 

10.5 Activating ICR Call Forward 
Once scenarios are saved, the ICR feature can be activated to forward your calls using the 
scenarios.  When a call is received, to your iPECS phone the UCS Server compares the call 
parameters to scenarios and routes the call appropriately. 

 
To activate the ICR Call Forward feature: 

１. In the ICR window, select the Scenario(s) by clicking to highlight. 

２. Click on the CFWD icon tool. 

３. Select the Forwarding Type from the drop-down menu. Available choices include: 
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 Clear 

 Unconditional 

 Busy 

 No Answer 

 Busy/No Answer 

４. Click on the OK button activate ICR. 

10.6 Using My Agent Control 
You can define another UCS Client user as an Agent that can view and modify your scenarios.  
You can register only one Agent, but can be the Agent for multiple other UCS Client users. 

To manage Agent definitions: 
１. Select the My Agent icon; the My Agent popup menu displays. 

２. Select Register My Agent to assign an Agent, 

OR 

３. Select Delete My Agent to remove your Agent. 

 

10.7 Scenario Menu 
In addition to the ICR icon tools, the Scenario menu can access the Scenario Wizard.  From 
the Scenario menu, you can add, edit and delete a scenario.  Adding and editing a scenario is 
discussed in Section 10.4 

To delete a scenario: 
１. Right-click on a scenario in the Scenario list, the Scenario menu appears. 

 

２. Click Delete; a confirmation window appears. 

３. Select OK to delete the scenario. 
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Chapter 11  
Collaborative Session Tools 

Other collaboration tools include Instant Messaging (IM), Sending files, Sharing, Web Push and 
Video Conferencing.  In conjunction with the Voice and Video communication, a complete 
multi-media communication session involving text and graphic messages, sharing, Web Push, 
and sending files can be established with the UCS Client.  The tools are under the main 
application Tools menu, in right click popups (Presence, Log and Call windows), and the 
Selected Contact window.  This section covers the use of each of the collaborative session 
tools. 

11.1 Instant Messaging Introduction 
IM is an IP-based near real-time communication service for text information.  You can create 
and send a message to other UCS Client users in the IM session.  Other users can create and 
send responses as they desire. 

An IM session can be created as a 1:1 Chatting session, or Multi Chatting session can be 
established.  Message dialog can be stored locally as a Rich Text Format (RTF) file. 

NOTE 
You must be online to initiate, be invited to, or to join an IM session. 
Basic emoticon(Unicode emoticon) used in Mobile Client is not supported in Windows Client. 

 

11.1.1 Initiating 1:1 Chatting 
For 1:1 Chatting, the IM window may be opened from the main window Tools menu as part of 
an active call or video conference using the IM icon tool.  Once an IM window is opened, 
additional participants may be added using Invite from the IM menu. 
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To start an IM session from the main application menu: 
１. Select IM from the Tools menu, which displays the Select Member window. 

２. Select the desired members from the Member List area, and click Add to list the member in the 
Added Member List. 

３. Select OK to display the IM window (refer to Section 11.1.3). 

 
To start an IM session from any of the Main, video or other windows or popup 
menus: 

１. Right-click on an online user; the popup menu will display. 

２. Select IM from the popup menu. 

 

11.1.2 Initiating Multi Chatting – (P) 

Multi Chatting permits an IM session with multiple users, up to 50 at one time. During 1:1 
Chatting, you can initiate multi chatting by dragging any user from Presence View into IM 
window.  This function is supported in UCS Premium license. 
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11.1.3 Initiating Multi Chatting from Chatting List – (P) 

You can retrieve the chatting list created before entering a chat room by selecting any chat 
room from chatting list.  This function is supported in UCS Premium license. 

 
To enter a Chat Room: 

１. Select the Chat Room from Chatting List. 

11.1.4 IM Window Introduction 
The IM window is comprised of a number of areas including icon tools, Participant List area, 
message dialog area and message entry area. 

 

11.1.4.1 IM Icon Tools 
As with other windows, the IM window includes icon tools to place a call, start a video 
conference and tools to initiate other collaborative sessions with other participants in the IM 
session. 

Icon Tools area 

Participant List area 

Message dialog area 

Message entry area 
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When ending a session, text from the IM message dialog can be saved locally as an RTF file.  
To save an IM message dialog: 

１. Select Save from the IM window. 

２. In the File menu, select Save. 

３. In the popup, select the location and file name. 

４. Click OK to store the file. 

11.1.4.2 IM Participant List 
The Participant List area displays the participants in the session.  You may display summary 
information about individual participants. 

  

11.1.4.3 Sending IM Messages 
With the IM window displayed, you can send and receive messages. 

 
To send a text message: 

１. Enter the desired text in the message entry area at the bottom of the IM window. 

２. Click on Send to send the message to other participants. 

Your Message area (Right Side) 

Other user Message (Left Side) 
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11.1.5 IM Log 
If enabled, each IM sent is stored in the IM Log.  To enable the IM Log, refer to Section 3.2.3.4.  
The IM Log includes the date, time, sender, and receiver(s) of the message as well as the 
message text. The Log can be searched by any of the columns shown in the IM Log window.  

 

11.2 File Send Introduction – (P) 
You may send files located on your PC to other UCS Clients.  Up to three files can be sent to 
up to five selected UCS Clients at a time.  The maximum file size that can be sent is 1000MB.  
The receiving UCS Clients must be online and authorize receipt of the file before the file is sent.  
Received files are stored in the UCS Client PC directory defined in Setting window, refer to 
Section 3.2.3.4.  This function is supported in UCS Premium license. 

11.2.1 File Send Window 
The File Send window manages the transfer of files.  The window includes the list of users 
(maximum 5) to receive the files and the files (maximum 3) being sent.  Icons allow you to add 
or delete recipients and files as well as initiate or cancel a file transfer.  The recipient list 
includes a status display indicating the file transfer status and the percentage of each file 
transferred. 

 

To access the File Send window: 
１. Select File Send from the main, video or sharing windows, or various popup menus. 

To send files from the File Send window: 
１. Click the Add members icon. 
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２. Select recipients from the Select Member window (refer to Section 11.2.1.1). 

３. Click the Add files icon. 

４. Select files from the Browse for Folder window (refer to Section 11.2.1.2). 

５. Click on Send, the File column shows the transfer status. 

Status indications in the Status column are: 
 Requesting – Indicates the recipient has received the request to transfer files. 

 Allowed – Indicates the recipient has accepted the file transfer and the files are being sent. 

 Denied – Indicates the recipient has rejected the file transfer and the files are not sent. 

 Failed – Indicates no response from the recipient or an error occurred 

 Completed – Indicates the file transfer has been completed. 

 Canceled – Indicates the recipient has rejected the file transfer. 

11.2.1.1 Adding Member Recipients 
When you select the Add member icon, the ‘Select Member’ window is displayed.  From this 
window, you may select members to receive files.  A user must be online to be selected as a 
recipient.  

To select users to receive files: 
１. Select recipients from the Member List. 

 

２. Click on Add to move members to the Added Member List. 

３. Click OK to add the users as recipients and return to the File Send window. 

OR 

４. Recipients can also be added by selecting them from a main window then drag and drop them 
to the Select Members list in the File Send window. 
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11.2.1.2 Adding Files to Send 
When you select the Add files icon, the Open file window is displayed.  From this window, you 
may browse folders in the PC to locate the files you wish to send. 

To select files to send: 
１. Select the Add icon. 

２. Browse to locate the appropriate files on your PC. 

 

３. Select the desired file, and click OK to add the file to be sent. 

OR 

Files can also be added from a directory screen by dragging and dropping to the Select File 
area of the File Send window. 

11.2.2 Recipient Authorization 
When you select Send in the File Send window, recipients receive a popup notification that 
another user is attempting to send files to them.  The popup lists the name of the user 
attempting to send files.  The recipient may accept or reject the file transfer.  If the invited 
user accepts the file transfer, the File Send window displays and both the sender and receiver 
see the file transfer progress.  If the recipient rejects the transfer, your File Send window will 
show the file transfer status as denied and files are not sent. 

 

11.2.3 Opening Received File 
When files are received, they are stored in the directory defined under Section 3.2.3.4. The files 
can be opened immediately from the File Receive popup, using the normal PC file open 
sequence or from the UCS Client File menu:  
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１. Select Open Received Files from the File menu. 

２. Double click on the desired file. 

   ▶   

11.3 Application Sharing – (P) 
The application sharing function permits iPECS UCS Clients to share the information displayed 
in the Sharing Master Page with up to five (5) other UCS Client users.  You can share 
documents, spreadsheets, presentations and drawings in real-time.  The initiator or master 
maintains control of the shared material and can edit the material, which is immediately shown 
to other UCS Clients in the sharing session.  The master can pass control to another user in 
the session, permitting the new master full session control. 

Once the sharing session begins, any information that may appear in the master’s Sharing 
window, such as an incoming call popup, will be displayed to other users depending on sharing 
options, see Section 3.2.3.4.  To participate in a sharing session the user must be online.  
This function is supported in UCS Premium license. 

NOTE 
The ‘Any windows’ selection in the Application Sharing window must be enabled to share a 
browser in the Sharing window, see Section 3.2.3.4.  As you move the browser window to the 
Sharing Master Page, other users in the sharing session see the web page. 

11.3.1 Application Sharing Window 
The Sharing Master Page window manages the Application Sharing function.  At the top of the 
window is the sharing participant list with the controlling participant indicated by the marked 
radial button.  Icon tools are provided to add participants and files as well as to start and stop 
the sharing session.  The master can call and initiate other collaborative sessions with a 
selected participant by selecting from the ‘Others’ tool menu. 
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To initiate an Application Sharing session: 
１. Open the Sharing Master Page by selecting Application Sharing from any of the main, video 

or other windows or popup menus. 

２. Select participants for the sharing session (refer to Section 11.3.1.1). 

３. Select files to be shared (refer to Section 11.3.1.2). 

４. Click on Start to begin the session; this will send an invite message to the selected participants. 

５. If the invitation is accepted, files are shared in the Participant Application Sharing window (refer 
to Section 11.3.4). 

The sharing master can pass control to another participant.  The participant becomes the 
master and can then edit documents displayed.  To change control to another participant, click 
the radial button next to the participant name. 

NOTE 
Use One-click application sharing in the Tools menu (IM/Video/Call Tab), by clicking on the 
desired Tools menu item; a sharing session will begin with the selected contact and item. 

11.3.1.1 Adding Application Sharing Session Participants 
Selecting the Add member icon from the Application Sharing window, opens the Select Member 
window.  From this window, you can select up to five other participants for the session.  A 
user must be online to be selected as a participant. 

 
 

To select participants: 
１. Select the Add member icon (    ). 

２. Select participants from the Select Member window. 

３. Click OK to add the user as a file recipient and return to the Application Sharing window. 
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11.3.1.2 Adding Files to Share 
Up to five (5) files from the Open Sharing List can be shared at any one time.  The master can 
add and delete files from the list and multiple file types, documents, spreadsheets, slide shows, 
etc., can be selected.  Multiple files can be opened in the window simultaneously with the 
active file displayed on the top of the screen. 

 
 

To select files at any time during the session: 
１. Click the Open (    ) icon, the Open Sharing List opens displaying available opened and 

minimized files. 

２. Select files to be shared from the list.  

３. Click on OK to accept the change. 

 

Additional files can be added to the list from the Open Sharing List window. 

To select other documents: 
１. Click on the Open New Selection List. 

 

２. Select the document type, Document or Paint Board can be selected.  Selecting Paint Board 
opens a blank paint file.  If Document is selected, the Open window is displayed. 

３. From the Open window, browse folders in the PC to select files to share. 

４. Select the desired file(s). 

５. Click OK to add the file to the Sharing List. 

Certain types of files such as Internet browsers may not be recognized by the sharing module 
as applicable to sharing.  In this case, selecting ‘Any Windows in the Shared window’ allows a 
window to be dragged to the Sharing window for display to participants, see Section 3.2.3.4. 
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NOTE 
Modifying the ‘Any Windows in the Shared window’ setting will not affect an active sharing 
session.  To allow sharing all windows, you must terminate the active session and restart the 
sharing function. 

11.3.2 Application Sharing Participant Window 
When the initiator (Master) begins a sharing session by selecting Start, selected participants 
receive the Invite Message popup.  The invited user may then select Yes to join the session or 
reject the invitation by selecting No. 

 
If the user selects Yes to join the session, the Sharing Participant window is displayed.  This 
page displays the Member List at the top of the window.  The radial buttons in the master’s 
window indicates the controlling party.  The window displays the active shared file shown in 
the master’s window. 

 

At any time, a participant can leave the sharing session by selecting Stop in the upper right 
corner of the window. 

11.3.3 Other Participant Tools 
The window includes icon tools so the participant can call and initiate other collaborative 
sessions with a selected participant by selecting the appropriate icon tool. 
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11.3.4 Drawing in Program Sharing mode 
Drawing tools are included for creating drawings such as free-form lines.  During an 
application sharing session, clicking one of the Drawing mode icons next to the Others button 
selects a drawing activity. 

 
  : sets color 

  : sets line width 

  : selects a picture 

  : free-form line 

  : straight line 

  : ellipse 

  : rectangle 

  : clear all 

  : Exit 

11.4 Web Push – (P) 
Web Push service permits you to control Web Page views for other users.  In Web Push, you 
send or push a Web Page address (URI) to the online UCS Client of selected users; up to five 
(5) users may be selected.  After the selected users accept the Web Push, their PC’s Default 
Web browser opens and displays the Web page.  This function is supported in UCS 
Premium license. 

To push a Web page to other UCS Client users: 
１. Click Web Push from any of the main, video or other windows or popup menus. 

 

２. Click the Add member icon in the top right of the Web Push window. 

３. Select the desired recipients (maximum 5) from the list of users displayed. 

４. Enter the Web page address (URI). 

５. Click Send to send the request to the recipients. 
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Each recipient receives an invitation message and can accept or reject the invitation.  If the 
invitation is accepted, the recipient’s web browser opens and displays the pushed Web page.  
To accept the invitation, select Yes in the Invite Message popup. 

 

11.5 Video Conferencing and Broadcast – (P) 
The UCS Client uses a Web Cam and application to implement real-time video communications 
over an IP-based network.  Two types of video conference are available, the normal mode and 
the presentation mode.  In the normal video conference, each member sends and receives 
video from other members.  Up to nine (9) UCS Client users, including the initiator may be 
included in a normal Video Conference.  This function is supported in UCP/eMG Premium 
license. 

 
In the presentation mode, the initiator broadcasts video to all members and members send 
video only to the initiator.  The initiator can broadcast video to 31 parties and will receive video 
from all 31 members of the conference.  Note that in the presentation mode, the initiator will 
need a more powerful CPU to provide quality video. 

To initiate a Video Conference: 
１. Click Video or Video (Presentation Mode) from any of the main, video, or other windows or 

popups. 
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２. Click on the Add icon from the Video window to display the Select Member window. 

３. Select the desired parties from the Member List. 

４. Click OK; each selected party will receive a video call Invite Message popup and the inviting 
party will receive the Invite Status Message.  The status can be Accepted, Denied or No 
response.  

５. If the invitation is accepted, click on Send from the Invite Status Message window to transmit 
video. 

６. To add additional parties, repeat steps 2 through 6. 

UCS Client users without a Web Cam may be invited to a Video Conference and will receive 
video from the conference, but will not send video.  When receiving a video call, the invited 
user receives an Invite Message: 

７. Click Yes; the Video preview window will open with a preview of the PC Cam output. 

８. Click Send from the preview window to transmit video. 

 
 

To turn video transmission On or Off, 
１. Right-click below “My image”. 

２. Click on the Stop button. 

 
The Video window displays all parties, maximum 9, in your video conference.  You can display 
a single party if desired.  To display video from a single party in the Video Conference, double 
click the video frame of the desired party. 

NOTE 
Resize the Video window by clicking on the lower-right corner and drag to the desired size. 
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You also have access to tools to place calls or initiate other collaborative sessions with the 
video session participants. Icon tools are located at the top of the Video window of the initiator 
or for other participants, right click on your picture. 

 
To rotate a video image: 

１. Right-click on the video image. 

２. Select the desired video frame rotation. 

 

11.5.1 Video – Remote Monitoring 
A UCS Client located at a remote site can view the web camera output of another client.  To 
be able to monitor another client remotely, that client must be configured to allow monitoring 
and the monitoring client must be configured in the list of users allowed monitoring of the client.  
If the client is set for you to be monitored, the remote monitoring presence icon will be display 
on the right side of the contact record in the Presence window. 

To allow remote monitoring: 
１. Click on the Remote Monitoring Manager from the Video menu under the Tools main menu. 

 

２. Check Use Webcam Presence, and Show notification of monitoring to notify the client of 
the monitoring status. 
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３. Click on the Add button to add a user in the Allowed list. 

４. To password protect monitoring of the client, click the Password checkbox and enter a 
password. 

５. Click the Save button. 

To start remote monitoring: 
１. Click Start a Remote Monitoring from the Video selection in various menus and popups, the 

Remote Monitoring window will display. 

To start recording: 
１. Click the Recording button at the bottom of the Remote monitoring screen. 

２. To end recording, click on the Close button in the bottom of the screen. 

 

NOTE 
The recording capacity of your PC is limited only by the amount of free space on your hard disk, 
if your PC has sufficient free hard disk capacity, the recording will be saved. 

 

To start monitoring capture: 
１. Click on the Capture button at the bottom of the Remote monitor screen. 

Using Remote Monitoring to manage Recorded files: 
１. Select the Remote Monitoring File Manager from the Video selection of the Tools menu and 

other menus, the Remote Monitoring File Manager window will display. 

 
 Refresh – update the file list. 

 Delete – to delete the selected file. 
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 All Delete – to delete all the files. 

 File Send – send a file to other users. 

 Email – send an E-mail to the selected user with the file attached. 

 Call – make a call (remote monitoring of the target). 

11.6 Short Message Service (SMS) 
Short Message Service (SMS) allows you to send and receive text messages with other internal 
iPECS system users or external SMS users.  The UCS Client stores up to ten received 
messages; additional new messages are ignored.  Received messages are stored in the Log 
window after selecting the SMS icon in the main window.  There are two types of SMS, one 
internal SMS and the other Fixed Line (external) SMS. 

The iPECS system must be equipped and enabled to send and receive external SMS (Fixed 
Line SMS). Internal SMS is for internal users only.  All terminals including UCS Clients, iPECS 
Communicator and Ericsson-LG IP phones can send and receive text messages with other 
iPECS system users. (Fixed Line SMS may not be available as it is carrier/country dependent). 

 
To send a text message: 

１. Select SMS from the main, video or other windows or popup menus, the SMS window displays  

２. Select the Internal radial button to send to other iPECS users. 

OR 

３. Select the Fixed Line radial button to send an external SMS. 

４. Click the Add icon.  

５. From the Select Member window, select desired members and click OK. 

６. Enter the message in the Message to Send area. 

７. Press the Send button, the Result popup confirms transmission.  

To receive a text message: 
１. Click the SMS icon located in the Message and Status bar at the top of the UCS Client window. 
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11.7 Administrative Messages 
The UCS Administrator can send administrative messages to all iPECS UCS Clients.  While 
online or at login, the UCS Client displays the administrative message. 

 

11.8 Whiteboard – (P) 
UCS Clients can efficiently collaborate with other clients participating in a meeting using 
Whiteboard to share drawings and free-form text.  The drawing function of the Whiteboard 
uses lines, ellipses and rectangles to create pictures on the Whiteboard window; pictures can 
be deleted and moved.  This function is supported in UCP/eMG Premium license. 

 
At the top left of the Whiteboard are the tools icons to add members and manage the file.  To 
the right are the drawing tools discussed below. 

To initiate a Whiteboard collaboration session: 
１. Select Whiteboard from the main, video or other windows or popup menus, the Whiteboard 

window will display. 

２. Click the Member icon. 

３. From the Select Member window, select desired members and click OK.  Each selected party 
will receive a Whiteboard invite message popup, which they can accept, deny or ignore.  The 
inviting party will receive an invite status message. 
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４. If the invitation is accepted, click on Send in the invite status message to transmit the 
Whiteboard. 

５. To add additional parties, repeat steps 2through 6. 

   : sets the color 

   : sets line width 

   : select the picture drawn 

   : drawing free-form line 

   : drawing straight line 

   : drawing ellipse 

   : drawing rectangle 

   : clear all 

   : fits the Whiteboard size to the drawing area, or zoom (hold the button down). 

              : zoom setting 

11.9 Desktop Sharing – (P) 
The UCS Client users can share their desktop screen with another user.  When on a call, the 
user can give control of their desktop to another party on the call for drawing pictures, etc. using 
the Whiteboard.  This function is supported in UCP/eMG Premium license. 

 

NOTE 
Screen capture resolution can be adjusted to improve transmission speed during Desktop 
Sharing.  The lower the screen resolution selected the higher operating speed. 

 

To adjust the Screen Resolution: 
１. From the main menu, select File>Setting>Functions>Sharing>Desktop Sharing > Capture 

Resolution (10-100%) 

 

To initiate Desktop Sharing: 
１. From the main screen, click Desktop Sharing, and the Select Member window will appear. 

OR 

２. Click Desktop Sharing from the presence popup menu; the Desktop Sharing window will 
display. 

３. From the Select Member window, select the desired member and click on OK. 
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４. Each selected party will receive a desktop sharing invite message popup, while the inviting 
party will receive an invite status message.  The invitation can be accepted, denied or ignored. 

５. Click on the Send button from in the invite status message to transmit desktop sharing. 

 

To initiate the drawing mode: 
１. Click on Drawing Mode from the desktop sharing popup menu; the drawing tools window will 

display. 

   : sets color 

   : sets line width 

   : selects a picture 

   : free-form line 

   : straight line 

   : ellipse 

   : rectangle 

   : clear all 

   : exit 

 

To change the controlling user from the session initiator: 
１. Select Handover Control/Takeover Control from the desktop sharing popup menu. 
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Chapter 12  
Supplementary Features 

The UCS Client supports other supplementary features for the user’s convenience. 

12.1 Call from Outlook Contacts 
UCS Client users can dial the phone numbers from Microsoft Outlook contact databases easily 
through UCS Client.  UCS incorporates a TSP (Telephony Service Provider) for Microsoft 
Outlook to dial phone numbers from the Contacts through telephone systems.  Users 
download the TSP for UCS Client from UCS Server and install it. 

NOTE 
The dialing feature via outlook does not support 64 bit MS Outlook. 

 

To install the TSP for UCS Client: 
１. After login, from the main menu, select File > Setting > General > Outlook Integration. 

２. Click the link at the left bottom of the window, which will download the TSP installation file from 
the UCS Server. 

 

３. Download and run the TSP installation file. 

NOTE 
The link does not display if you already have the TSP installed. 
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To show Microsoft Outlook dialer: 
１. Run Microsoft Outlook and go to Contacts. 

２. Right-click on a contact and select Call Contact, which displays the Microsoft Outlook dialer. 

 
 

NOTE 
If you cannot find the Call Contact item in the popup menu, follow this link 
http://support.microsoft.com/kb/959625/ to correct the popup. 

 

To configure and dial the Outlook Contact numbers: 
１. Click the Dialing Options button to show the Dialing Options window. 

２. Choose UCS Line from the Connect using line box. 

 

 
 
 

http://support.microsoft.com/kb/959625/�


 

 
140 iPECS UCS Client for PC User Guide - Issue 4.7 

３. Click OK, and in the New Call window, click Start Call.  The UCS Client will place a call to the 
Contact number through the iPECS system. 

 

NOTE 
You can check the dialed digits from LCD in UCS Client’s Phone tab.  You may need to 
configure Dialing Rules for proper operation, refer to Section 3.2.3.3. 
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12.2 CRM Integration – (UCP/eMG) 
UCS Client supports CRM integration with well known CRMs such as Salesforce.com or 
Microsoft Dynamics CRM. CRM Integration enables contact popping and caller preview when a 
call is made or received.  This function is supported in UCP/eMG Premium and Standard 
license. 

NOTE  
For ucs user to use CRM Integration, below settings are needed: 
1) In case of UCS Standard License, [UCS CRM USE] option should be set to ON. You can find 
[UCS CRM USE] option in Unified Web Admin – PGM112. 
2) In case of UCS Premium License, [Allow CRM Integration] option should be checked. You 
can find [Allow CRM Integration] option in UCS Server Web Admin – Use Feature Permission. 

12.2.1 Installing UCS CRM Integration 
Select File > Setting, then click CRM Integration menu. If CRM Integration is not installed in 
local PC, then download  and install  UCS CRM Add-in on UCS Web Admin login Page > 
[Installing UCS Client Program] in case of Premium License.  In case of Standard License, 
Please contact UCS administrator to install UCS CRM Add-in 
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Installing UCS CRM Integration: 
１. Start installation by clicking [CRM Integration] button. On the Setting page. 

２. Click [Download] button. 

 

３. Click [Run] run to start installation. 

 
 

４. Continue installation by clicking Install button. 
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５. Complete by clicking Finish button. 

 
 

６. If CRM Integration is installed, UCS CRM Integration download link will be disappeared. 

  



 

 
144 iPECS UCS Client for PC User Guide - Issue 4.7 

12.2.2 CRM Configuration 
When [Enable CRM ] option is checked, CRM search is enabled .  In case CRM search result 
is single, when [Enable CRM] and [Use CRM Pop-up] options are checked, CRM Popup is 
displayed automatically without clicking [show contacts] button. 

 
 

CRM Configuration: 
１.  Click [CRM Configuration] button on Setting > CRM Integration menu, then CRM Setting 

window is activated.  
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２. Click Integration - [Add new] button and select [type] button, then CRM list is displayed.  

 
 

３. Select a CRM from CRM list, then specific menu of selected CRM is displayed (ex, 
Salesforce.com)  

 

４. After CRM is added, make sure that CRM is successfully loaded on CRM Integration. You can 
check CRM Integration state on Log Menu. If Integration State is a [LOADED], it means that 
UCS can search and pop-up contacts information through this added CRM. 
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12.2.3 CRM Search and Contact pop-up 
 

CRM search and Contact pop-up using CID when a call is made or received 
１. If CRM is added correctly, [CRM – Show Contacts] button will be shown on Call View window 

when caller’s CID is searched in registered CRM. 

 

２. Click [CRM – Show Contacts] button, then searched user list will be shown. 
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３. Click Name field of searched user list, then detailed information of CRM will be shown.  

 



 

 
148 iPECS UCS Client for PC User Guide - Issue 4.7 

12.3 URL Pop-up – (UCP/eMG) 
URL Pop-up function is for popping-up  web page  with URL when user makes a call or 
receives a call.  %tel% of URL is replaced with Phone Number.  This function is supported 
in UCP/eMG Premium and Standard license. 

12.3.1 UCS Pop-up configuration 

 
 

１. Select File > Setting, then click CRM Integration menu. 

 

２. When [Enable URL Pop-up] option is checked, URL Pop-up function is enabled. 

 

３. When user make a call or receives a call, web browser pops-up inserted URL. %tel% is 
replaced with Phone Number. 
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４. You can configure URL Pop-up by call status. For popping–up URL during ringing or ring back, 
you need to check [Ringing] or [Ring back] option 

 

12.4 System Failover 
In case UCP/eMG system is under the T-Net, when Call Service is unavailable due to Active 
CCM and Standby CCM are disconnected by some reasons, UCS Client can access to LCM 
which is involved in and use Call Service. 

 This function is supported in UCP/eMG Premium license. 

12.4.1 On Local Survival 
When Active/ Standby CCM is disconnected in T-Net, UCS Client can access to LCM which is 
involved in and use Call Service.  It displays [On Local Survival] to let user to know that UCS 
Client service is restricted except call. 

 
 

NOTE  
For UCS Client to connect with LCM, please check below 
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1) To connect with LCM, UCS Client should register same user information as Premium license 
which is registered in CCM to LCM as standard license. 
2) UCS Client which is connected in LCM is available to use call service. 
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Chapter 13  
Call View & Call Function 

When call is received or placed, the active Call View screen displays with various user call 
function buttons to manage the call. 

13.1 Active Call 
The active Call View displays the Caller id with picture and various call function buttons 
including the list below.  

 
 Reject/Answer/Mute Ring (incoming call pop-up) 

 Dial Pad access button 

 Video Call start/accept/stop 

 Ringing Call transfer 

 Active Call transfer 

 Call hold 

 Hang-up 

 Call park 

 Record Call 

 Mute 
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13.2 Call Functions 

13.2.1 Call Answer/Reject  
When receiving a call from others, the inbound Call View displays. You may answer the call - 
press the Answer button, or reject the call - press the Reject button. If desired, the Ring signal 
may be muted. You can send the call to your voicemail - press the Voicemail button. The call 
can be transferred to another user or user’s voicemail or your voicemail while the call is ringing 
without answering the call. 

 

13.2.2 End a Call  
From the active Call view, selecting the Hangup button terminates the active call. 

 

13.2.3 Video Call 
You can start a video call while on the phone by pressing Video button. 

  ►   
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13.2.4 Call transfer while receiving ring tone 
You can transfer call while receiving ring tone as the below. 
 
 Call transfer 

 Call transfer with Voicemail 

 Call transfer with user’s voice mail 

 Call transfer by drag and drop 

 
To transfer the call 

１. Clicking call transfer button (    ) in the call view while receiving ring tone as below. 

 

２. The dial pad displays, dial the station number to receive the call.  

 

３. Select the type of transfer,  
Screened Trans: await answer to announce the call 
Unscreened Trans: hang up after selection 
Voicemail: send the call to the station user’s voicemail 
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To transfer the call by Drag and Drop 

 

１. When dragging picture area of CallView window into Presence Tab, Phone Number will be 
displayed. 

２. Drop into displayed number, call will then be an unscreened transfer. 

13.2.5 Call transfer while call connection 
You can transfer call while receiving ring tone as below: 
 
 Call transfer 

 Call transfer with Voicemail 

 Call transfer with user’s voice mail 

 Call transfer by drag and drop 

 
To transfer the call 

１. Clicking call transfer button (    ) in call view while receiving ring tone such as below.  

 

２. The dial pad displays, dial the station number to receive the call. 
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３. Select the type of transfer,  

 Screened Trans: await answer to announce the call 

 Unscreened Trans: hang up after selection 

 Voicemail: send the call to the station user’s voicemail 

 

To transfer the call by Drag and Drop 

 

１. When dragging picture area of CallView window into Presence Tab, Phone Number will be 
displayed. 

２. Drop into displayed number, the call will then be an unscreened transfer. 

 
To retrieve screened transferred call 

１. When call is screened transferred, screened trans. Button will be changed into Retrieve Button. 

２. When unscreened transferred call is ringing, that call can be retrieved by clicking Retrieve 
Button. 
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13.2.6 Call Hold 
You can place the call on hold, press the Hold button, to perform another task or place a call.  
While on hold, the party receives music from the iPECS system. The call may recall if held too 
long.  You reconnect to the call by pressing the Hold button again. 

 

13.2.7 Call Park – (P-UCP/eMG, S)  
You can place the call in a ‘Parking Orbit’, where others can easily access the call. The call is 
parked by pressing the Park button. You may then inform the desired party to access the 
Parking Orbit. This feature is often used with internal paging to page the desired user. 

When you park calls, the parked call message icon indicates the number of calls you have 
parked.  Selecting the icon displays the Parked call list, where you may reconnect to a parked 
call by selecting the call.  This function is supported in UCP/eMG Premium license. 
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13.2.8 Call Recording 
Selecting the Record button records the call to the UCS Client directory.  Note the recording 
includes audio starting from when the button is selected.  You can stop the recording using the 
same record button. 

13.2.9 Muting Your Audio 
You can mute the active microphone so the connected party will not be able to hear audio from 
your microphone by pressing the Microphone button.  

13.2.10 CallView Pop-up Position Setting  
Pop-up Position of CallView can be configured as below. When UCS Main Window is not 
shown, CallView is located in selected Pop-up Position 
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Chapter 14  
Audio Conference Manager 

The Audio Conference Manager permits the UCS client user to manage both Add-on and Room 
Conference calls.  MCU (ex,MCIM) must be installed for Audio Conference.     

14.1 Add on Conference 
Add-on Conference allows you to establish a conference and add members on an Add-on basis. 
In addition, you may control audio from other conference members and delete members of the 
conference as discussed below. 

 
 Invite/Remove a member 

 Mute a member 

 End the conference 
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14.1.1 Inviting/Removing a member 
As the master, you can invite and remove conference members. 

Inviting a member 
► Input station number or external telephone number, then press invite button. 

 In case of station number 

 
 In case of external telephone number 

 

Removing a member 
► Press remove button (   ) 

14.1.2 Muting a Member – (UCP) 
A master can mute a member (eMG system does not supported this function).  This function 
is supported in UCP system. 

Muting a member 
► To mute a member, press mute button (   ). 

► To cancel the mute, press mute button again. 

14.1.3 Ending the conference – (UCP/eMG) 
A master can end the conference.  This function is supported in UCP/eMG system. 

► To end the conference, press end button (    ). 

14.2 Room Conference 
With the UCS Client, you can establish a Conference Room, which others can join by entering 
the Room. Functions available in a Conference Room are similar to those of an Add-on 
Conference as discussed below. 
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 Reserve / Release a room 

 Entering / Exiting a room 

 Inviting / Removing a member (master only) 

 Muting a member (master only) 

 Changing the master (master only) 

 Ending the conference (master only) 

14.2.1 Reserving/Release a Room 
You can reserve / release a room from the conference call list. 

Reserving a Room 
１. Select the Reservation button (   ).  

 

２. The Create room window appears allowing you to assign a password for the room. Input a 
five-digit string in Password attributes, then press OK button. If a password is not required just 
press OK button. In case of template room, input the pre-programmed password. 

 

３. If a room is reserved, then the create button does not appear.  Instead the enter room button 
(    ) appears and, if selected, you will enter the room.  

 
 
Releasing a room 

１. Press release button (    ).  

 

２. If the room has password, input the password, then press OK button. If no password, then just 
press OK button. 
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３. If a room is released, others may now reserve the room. 

 

14.2.2 Checking Members of a Template Room – (UCP/eMG) 
You can check the members associated with a template room.  This function is supported in 
UCP/eMG Premium system. 

► Press template room check button, then the information of members is displayed. 
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14.2.3 Entering/Exiting a room 
 

Entering a room 
► If a room is reserved, the room enter button is displayed. Press the room enter button (    ). 

The display after entering a room is as below. 

 

Exiting a room 
► Press the room exit button. 

14.2.4 Inviting a Member 
A master can invite and remove conference members. 

Inviting members 
► Input station number or external telephone number, then press Invite. 

 In case of station number 

 
 In case of external telephone number 
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14.2.5 Muting a member – (UCP/eMG) 
As the master, you can mute the audio from other members (eMG system does not support this 
function).  This function is supported in UCP system. 

Muting a member 
► To mute a member, press mute button (   ). 

► To cancel the mute, press mute button again.  

14.2.6 Changing the master – (UCP/eMG) 
As the master, you can pass control of the conference to another member.  This function is 
supported in UCP/eMG system. 

 
 

 

14.2.7 Ending the conference – (UCP/eMG) 
As the master, you can end the conference.  This function is supported in UCP/eMG system. 

► To end the conference, press end button (   ).  
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Chapter 15  
Visual Voicemail – (UCP/eMG) 

Visual Voicemail provides the user with a graphical representation of their voice mailbox 
messages, permitting simple management and interaction with (play, pause, stop, delete and 
call to sender) the voicemail.  This function is supported in UCP/eMG system. 

15.1 Usage for Visual Voicemail 
The Voice Mail status button in the Message and Status bar indicates your new message status 
as shown in the figure below. Selecting the button will display the Visual Voice Mail window. In 
the window, you may access the various controls as listed below. 

 
 Play / pause / stop Voicemail 

 Delete Voicemail 

 Save Voicemail 

 Call to sender of Voicemail 

 Send downloaded Voicemail by outlook email 

 Offline Voicemail 

15.1.1 Play/ Pause /Stop Voicemail 
You can play/ pause/ stop voicemails in the Visual Voicemail window. 
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Play voicemail 
► To play voicemail, click the play button (   ).  

 
Pause voicemail 

► To pause voicemail, click the pause button (   ).  

 
Stop voicemail 

► To stop voicemail, click the stop button (   ).  

15.1.2 Delete Voicemail 
You can delete voicemail from the Visual Voicemail list. 

Delete voicemail 
► To delete voicemail, click the delete button (    ) after selecting voicemail in the Visual 

Voicemail list. 

15.1.3 Save Voicemail 
You can save voicemails to your PC hard drive. User can change the voicemail Receiving 
Folder in Setting -> Functions -> File menu. 
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Save voicemail 

► To save voicemail, click the save button (    ) after selecting voicemail in the Visual Voicemail 
list.  

 

15.1.4 Call to Sender of Voicemail 
You can return a call to the sender of the voicemail.  

Call to sender 
► To call the sender, click the Call button (   ) after selecting voicemail in the Visual Voicemail 

list. 

15.1.5 Send downloaded Voicemail by Outlook email 
Send downloaded voicemail by Outlook email 

► To send downloaded voicemail by outlook email, click the Email button (    ) after selecting 
voicemail in the Visual Voicemail list. 

15.1.6 Offline Voicemail 
You can listen to the downloaded voicemails in offline status without login. 
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Appendix A:  
Useful Information 

This chapter discusses the open source software used in the UCS Client. 

A.1 Open Source Software Notice 
Open Source Software used in this product are listed as below. You can obtain a copy of the 
Open Source Software License from Ericsson-LG Enterprise Web site, http://www.ericssonlg-
enterprise.com. Ericsson-LG Enterprise reserves the right to make changes at any time without 
notice. 

Open Source License 

appweb LGPL 

bash  

bluez  

busybox 1.8.1  

dbus  
dhcpcd  
glibc  
iproute2  
wpa  
linux 2.6.35.7  
lzo  
ntpclient  
openlldp  
openssl OpenSSL Combined License 
openvpn  
sqlite  
tcpdump  
tslib  
supplicant  
FFmpeg LGPL v2.1 or later 

MS Server 2003 Platform SDK Samples MS Server 2003 SP1 SDK License for sample 
code 



 

 
168 iPECS UCS Client for PC User Guide - Issue 4.7 

org.apache.commons.net.ftp.FTP Apache 
org.apache.commons.net.ftp.tftp Apache 
  

 
Ericsson-LG Enterprise offers to provide you with open source code on CD-ROM for a charge 
covering the cost of performing such distribution, such as the cost of media, shipping and 
handling upon e-mail request to Ericsson-LG Enterprise at opensource@ericssonlg.com 

This offer is valid for a period of three (3) years from the date of the distribution of this product 
by Ericsson-LG Enterprise. 
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